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Introduction 

Description 

The Orion Graphical Package allows the user to easily connect to Squid Ink 
manufacturing printers and create industrial inkjet message files using a powerful 
graphical user interface. 

Orion is a 32-bit Windows application that executes on any host computer running the 
following operating systems: Windows XP Service Pack 3, Windows Server 2003 Service 
Pack 2, Windows Vista Service Pack 1 or later, Windows Server 2008 (not supported on 
Server Core Role), Windows 7, Windows Server 2008 R2 (not supported on Server Core 
Role), Windows 7 Service Pack 1, Windows Server 2008 R2 SP1, Windows 8, Windows 
8.1. 

System Requirements 

Operating System: Windows® XP Service Pack 3 (SP3) or later 
Processor: Pentium® II, 1 GHz (or higher) 
Memory: 512 MB 
Hard Disk Space: 50 MB (512 MB if Microsoft .NET Framework 4 and Adobe Acrobat® 

Reader are also installed) 
Video: 4 MB, Windows® XP compatible SVGA 
Resolution: 800 x 600 
Color Depth: 16-Bit recommended
Ethernet Port: IEEE 802.3 10BASE-T, 10 Mbps minimum, RJ-45
Firewall: Orion needs access to the printer though Port 21 for FTP

connections, Port 4000 for TCP/IP connections and Port 46810 for
multicast communications.

Privileges: Must have Administrator privileges to install. Non-administrators
may run the applications if the appropriate privileges are applied to
the folder where the applications are installed (when installed
under “\Program Files”). For example:
• Right-click the \Orion folder and select Properties.
• Select the Security tab*.
• Select the user group you want to modify (usually “Users”).
• Allow Modify and Write privileges and click the OK button.
The modified group will now be able to run the Orion software
without any problems.
* If the Security tab is not visible, open an Explorer window and
select ToolsàFolder Options, select the View tab, scroll down to
the bottom of the list and uncheck the “Use simple file sharing”
option, then click “OK” button.
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If your system does not meet these requirements, the software may not operate as 
expected. You should cancel the installation and re-run on a system that meets these 
requirements. 
 

Basic Concepts 
 
Messages created using the Orion™ Software package can be transported to printers 
four ways: 
 
Through a local area network: 

 
 
Direct connection from a desktop device: 

 
 
Saving to a USB device and physically moving to the printer: 

 
 
Through a WiFi connection: 
 

 
 
 
 
A note about print stations and printers 
Orion™ Software is easy and simple to use. A print station is created and printers are 
assigned to the print station. Print stations are not printers. A print station is where 
printing will occur. Printers are then assigned to print stations. 
 
Understand how print stations are created and how printers are connected. 
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The Good News 
 
You probably won’t need to read much of this manual. After you have developed a good 
understanding of print stations and printer connections the Orion™ Graphical Software 
Package is very intuitive and easy to use. A description of most functions and tools can 
usually be seen by letting the mouse pointer hover over an icon in the Orion message 
editor. 
 

 
 
The “Getting Started” section of this manual will provide brief instructions for quickly 
creating and printing messages. 
 
With a little practice and experience an operator can become comfortable using the 
Orion™ Message creation Software. 
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Getting Started 

Installation 

To Install the Orion™ Graphical Software Package: 

Go to www.squidink.com. 

Hover over the “Product” tab and from the drop down menu click on Orion. 

Mouse click on the highlighted link to download the Orion setup package “Squid Ink 
Orion Setup.exe” file. 

Run the downloaded “Squid Ink Orion Setup.exe” on the desired computer and follow 
the screen prompts to complete installation. 

Orion License Model 

Orion License Model includes a Software License to enable Orion to send messages to 
multiple printers at a time and a Feature License to enable/disable Orion to connect to 
special printer types (PRO2, AutoPilot2) called “Special Printer Support”. 

Software License 

Basically, there’re 3 levels of Software License for Orion product: 

Tier 1 – Printer License (Free) 
Includes “Operator Mode” functionality for customers using their own Windows™ tablet. 
This software is included in the Squid Ink Tablet kit. 

Tier 2 – Unlimited Printer Licenses and Message Design 
Tier 2 Includes Tier 1 and allows for connection to an unlimited number of printers. 

Tier 3 – Required for Database Server and Auto Data Server Functions 
Tier 3 has all Tier 1 and 2 message creation and editing functions and also includes the 
Database Server and Auto Data Server options. 

http://www.squidink.com/
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Activation 

From the “File” drop down menu click the “Orion 
Activation…” button located at the bottom of the 
menu. 

The Orion Activation window will open. 

There is a license number located on the “DOWNLOAD INSTRUCTIONS” card that 
came with your CoPilot, SoloPilot or Jetline Printing System. 

################## 

License Number 
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The Orion™ Software is shipped with a free license for one printer. If a higher level of 
license was purchased follow the instructions for activating the multiple printer license. 
 

 
 
For additional printers beyond the free license, enter the License Number from the 
DOWNLOAD INSTRUCTIONS card in the “License Number:” box and click the 
“Activate License” button. You will then be able to connect to more than one printer. 
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Adding a Print Station 

The Print Station is the surface and production location where printing will occur. Keep 
in mind that the Print Station is not a printer. Printers are added to print stations after a 
print station has been created. 

Note: If there are no existing print stations the Print Station 
Wizard/New Print Station dialogue box will automatically 
open when Orion™ is launched. 

To add a print station, click the “Add a Print Station” icon 
from the top menu bar. 

The “Print Station” dialog box will open. 

In the print station dialog box you 
can: 

• Give the print station a
unique name.

• Specify the substrate type.

• Define the product 
dimensions.

• Specify the surface(s) to
be printed on.

In this example we will name our print station “Practice 1”. We will be printing on a 
“General Box”. To keep this example simple we will retain the default dimensions and 
print on the front surface only. 

Select “OK” to save the print station. 

The print station now appears in the “Print Station” list 
on the left of the screen as “Practice 1”. 
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Adding a Printer 

Now we are going to add a printer to print at our Print Station (Practice 1). 

In the Print Stations list, select “Front”, then click the “Add Printer/Printhead” icon from 
the top ribbon menu bar. 

The “Add Printer/Printhead” dialog box will open. 

This is a new installation so there are no existing 
printers listed. 

Orion can find all online printers in the LAN scope 
automatically. To search for a printer click the 
“Automatically Locate Printer…” button. 

Note: When you first run “Automatically Locate Printer…” Windows 
Security might pop up an alert for you to allow Orion access 
Windows firewall. You should choose “Allow access” here. 
Or you can’t locate any printer. 
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The Orion™ Software 
Package will then begin a 
search of all printers 
connected to the Local Area 
Network. 
 
 
 
 
 
 
 
 

 
A list of all available located printers will 
be displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Check the printer you wish to use and 
click “OK”. 
 
A dialog box will open asking if you want 
to continue to retrieve the printer’s 
configuration data. Select “Yes” to 
continue. 
 
 
 

 
 



18   Getting Started 

The selected printer will now appear in the “Print 
Stations” list under “Practice 1”. 

A CoPilot printer has now been defined to print the front surface at “Practice1” print 
station. 
To select an additional printer open the “Add Printer/Printhead” dialog box again and 
select an additional printer to add to the print station. 

A CoPilot and a Jetline printer have now been defined to print the front surface at 
“Practice 1” print station. 

Reminder! A print station is not a printer. It is a location where printing will 
occur. Printers are added to print stations. 
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Configuring an Assigned Printer 

To configure a printer that has been assigned to a print station, make sure “Print 
Stations” list is displayed. If not, from the “View” tab click “Print Station Explorer” 
button. A list of print stations and assigned printers will be displayed at the left side. 

In the print station explorer right click on 
the printer to be configured. From the 
drop down menu select “Configure 
Printer…” 
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A printer configuration window will be opened in Orion workspace titled with the printer 
name and serial number. In the window can be found several tabs and options for 
setting the printer properties. 
 
Click on the “Print Configuration” tab in the Printer Configuration window. The “Print 
Configuration” page for the selected printer will open. Here you can make changes to 
the printer. 
 

 
 

Print Configuration for the Assigned Jetline Printer 
 

 
 

Print Configuration for the Assigned CoPilot Printer 
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If any changes have been made to the printer configuration select the “Apply” 
button in the configuration section of the tools ribbon to apply the defined 
properties to the printer. 
 

 
To Save the current print configuration in Orion select the “Save” icon in the 
configuration section of the tools ribbon. 
 
 

 
Attention! The save icon in the print configuration only saves to the 

local configuration file in Orion. It does not apply the 
changes to the printer yet. 

 
If you make changes and close the printer configuration display without saving you will 
be asked if you want to save the configuration changes for the selected printer. 
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Orion and Windows Firewall 

In Orion, when you try to locate printers automatically for the first time, Windows 
Security might pop up a “Windows Security Alert” (see screen shot below). You must 
choose “Allow access” here. 

If you should accidently close the dialog box by clicking on “Cancel” or “X”, you may go 
to “Control Panel” => “System and Security” => “Allow a program through Windows 
Firewall”. 

In the “Allowed programs and features” list, find “Squid Ink Orion System” and click to 
highlight it and click “Change Settings”. 

Then the list will be enabled for edit. Make sure all the check boxes in the Orion line are 
checked. Click “OK” to close the dialog. 



Getting Started   23 

Creating a Message 
 
Message creation using the Orion Software Package is very simple. 

 
Select “New” from the drop down File Menu. 
 
The “New Message” dialog box will open. 
Here we can name the message file. Input the 
message name then click “OK”. 
 
 

 
 

The Message creation screen will appear in Orion workspace. Here is where elements 
are placed in the message. 
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Placing Elements in a Message 
 
Place a Text Element in the Jetline Printhead 
 
The message creation screen will display printheads for all the printers defined for the 
current print station. 
 
In the following example there is one printhead displayed for the connected Jetline 
printer and two printheads displayed for the connected CoPilot. 
 

 
 
Use the mouse to click in the Jetline Head #1 printing area where you wish to place an 
element. The printhead will be highlighted indicating it’s currently selected. Notice in the 
above example the Jetline printhead is highlighted. 
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To place an element into the message select the “Insert” tab on the top menu ribbon for 
a display of available elements. Click the type of element to be placed in the message. 
 

 
 

You can also right click the mouse on the substrate (printing 
surface) and a drop down list of available elements will appear 
on the screen. 
 
 
 
 
 
 

For example to create a text element, right click the mouse on the printing area and 
select “Create Text” Here” from the drop down context menu. Or click the “Text” icon 
from the “Insert” tab. 
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The Text properties menu will display on the screen. 

Here the text element can be edited. All the associated attributes connected with the 
selected text element can be changed. 

For example: to print “SQUID INK Manufacturing” on two lines using DOD7X5 Regular 
font left justified the properties menu would look like this: 

Text Properties Menu 

To print two lines of text as in the above example, in the text string box use the Control 
+ Enter to wrap to the second line or click the “New Line” button.

Another Element 

To place a Time element in the Jetline printhead right click the mouse on the printing 
area and select “Create Time Here” from the drop down context menu. Or select the 
“Time” icon from the “Insert” tab. 
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Time Element Properties Menu 
 

 
 
The Time element has been added to the message. 
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Placing Elements in the CoPilot Printheads 
 
To place an element in a CoPilot Printhead click on the CoPilot Head #1 area on the 
message creation screen. The CoPilot printhead will be selected and highlighted. 
 

 
 
With the CoPilot Head #1 highlighted, select the “Insert” tab on the top ribbon menu for 
a display of available elements. Click the type of element to be placed in the message. 
 

 
 

You can also right click the mouse on the substrate 
(printing surface) for CoPilot Head #1 and a drop down 
list of available elements will appear on the screen. 
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Create a text element and the Text properties display will open for you to change text 
attributes. 

In the above example we have placed two lines of Arial Black text, 64 jets in height. 
Remember to wrap text into two lines press the “Ctrl + Enter” keys to wrap text to a 
second line. 

Place a barcode in the message 

With CoPilot printhead #1 highlighted in the message creation screen, click the 
“Barcode” icon from the insert ribbon tab. 

Or 

Right click in the CoPilot Head #1 printing area and 
select Barcode from the drop down context menu. 

The Barcode Properties ribbon will display. 
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Here we have created a QR-Code for the Squid Ink Manufacturing web site on CoPilot 
Head #1. 
 

 
 
Here we have entered another text string “www.squidink.com” on Head #1. 
 

 
 
Notice that the properties ribbon for the selected element is displayed. 
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Place an Element on CoPilot Printhead #2 
 
Select and highlight CoPilot Printhead #2 in the message creation screen. 
 

 
 
We are going to add a graphic from an existing image file to CoPilot Head #2 in the 
message. 
 
With CoPilot Head #2 highlighted, select the “Insert” tab on the top menu ribbon for a 
display of available elements. 
 

 
 
Or 
 

You can also right click the mouse on the substrate 
(printing surface) for CoPilot Head #2 and a drop down 
list of available elements will appear on the screen. 
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Click the “Image File” icon from the “Insert” ribbon. 
 

 
 
You can also right click in the CoPilot 
Head #2 print area and select “Create 
Graphic Here” > “From Image File…” 
from the drop menu. 
 
 
 
 
 
 
 
 

 
A navigation window will open and you can navigate to the location where the image 
resides. In this case to keep things simple I have selected a COPILOT logo stored on 
drive (C:) in a “CoPilot” directory I created. 
 

 
 
Select “Open” to retrieve the graphic. 
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The graphic will be placed in CoPilot Head #2 in the message. You can click and drag 
the graphic to a new position or resize it. 

There are some native graphic tools like line, rectangle and a built in graphics gallery in 
Orion™ that can be used directly. Click on corresponding tool icon or select an existing 
graphic from the drop down gallery list in “Graphic Element” ribbon group while the 
desired printhead is selected. 

Here I have placed an ellipse, a rectangle and an arrow logo in the CoPilot Head #2 
print area. 
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Printing the Message 
 

 
 

To print the current message, select the “Send to Printer” icon in the Message 
tab. The message will be sent to corresponding printer(s) ready to print. 
 
 
 

 
You can select the “Export to USB Disk” to save the message on a removable 
USB disk. The USB disk can then be physically moved. When plugged into 
USB port of a corresponding printer, the message can be loaded into the 
printer ready to select and print. 
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Static Menu Tabs 
 
When the Orion Graphical Software Package is first opened there will be three menu 
tabs in the top left corner of the Orion Window. 
 

• File 
 

• Home 
 

• View 
 

 
 

File 
 
The “File” tab contains normal 
message operation and related 
functions such as opening, 
saving and printing messages 
also some system function 
buttons. 
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File>New 
“New” will open a new message creation window. 
 
 

File>Open 
“Open” is for opening an existing message that has been already been 
created in Orion. 
 
 

File>Save 
Select “Save” to save changes to the current message. 
 
 

 

File>Save As 
Select “Save As” to save the current message with a different name. 
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File>Save Selected as Bitmap 
Any selected elements in an open message can be saved 
as a bitmap image. The bitmap file can be saved to any 

location. To save an element as a bitmap file navigate to the location where you would 
like to save the file and enter a file name in the “File name” box. Select “Save” to save 
the file. 
 

 
 
 
 

File>Close 
Select “Close” to close the current message. After selecting “Close” 
you will be asked if you want to save the changes for the message 
before closing. 
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File>Send To Printer 
”Send To Printer…” will send the current message to the 
connected printers for printing. The “Send Message to Printer” 
window will open. 

 

Send Message To Printer Window 

 
 
The “Send Message To Printer” window will list all the printers assigned to the 
message being sent on the left. On the right side of the window additional connected 
printers are listed. 

 
The “Reset” button will reset printers assigned as target printers to the 
message pre assigned printers. 
 
The “Refresh” button will update the list of connected printers available 
to add to the message target. 
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If you have made changes to the current message you will be asked if you want to save 
before sending the message to the assigned printers. 
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File>Export To USB Disk 
“Export To USB Disk…” will save the current message on a 
removable USB disk. 

 

Export To USB Disk Window 
 

 
 

The “Reset” button will reset printers assigned as target printers to the 
message pre assigned printers. 

 
The “Add” and “Remove” buttons will move printers back and forth to the 
target list. Double clicking on a listed printer will also move the selected 
printer(s) to or from the Target printer list. 
 
 

 
The ”Printer Messages:” button will offer options for dealing with existing messages. 
Use the drop down arrow and select the desired option. 
 

 
 

Select the “OK” button to send the current message to the USB Disk. 
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Export To USB Disk Generic Printer: 
 
In the “Export To USB Disk” window there is an option to select “Generic Printer” at the 
top of the list of available printers. 
 

 
If “Generic Printer” is selected 
the message exported to the 
USB disk can then be walked 
around to any printer of the 
same type and loaded onto the 
printer. The message will not be 
tied to a specific printer ID. The 
Generic Printer option is 
available for JetLine and CoPilot 
printers. 
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File>Print 
Selecting “Print…” from the file drop down menu will allow 
you to print the current message on a selected office type 
printer. This is useful to see what a message will look like. 

 
Attention! “Print…” does not send the message to a Squid Ink industrial 

ink jet printer. It is only used to print a copy of the current 
message on an office type printer. 

 

 
 

File>Print Preview 
Selecting “Print Preview…” from the “File” drop down menu 
will display a preview of the current message. This is useful in 
seeing what the current message will look like. 
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File>Help 
Selecting “Help” from the “File” drop down menu will display 
the help window. 
 

In the help window you can access the 
Orion Software User Guide, the Jetline 
User Guide, the CoPilot User Guide and 
information about the currently installed 
Orion Software. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Should you need to contact Squid Ink 
Technical Services look in “About Orion 
Software” to determine the current version 
of Orion™ and the maximum number of 
printers can be licensed. 
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File>Activation 
The “Orion Activation…” button is located along the 
bottom margin of the “File” drop down menu. Select the 
“Orion Activation…” button to open the activation window. 

If the Orion Software installation is new or you have to change printers licensed to the 
current installation use the “Orion Activation…” window. 
 

Note: The Orion™ software package was shipped with a free 
license for one printer. 

License Activation Window 
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License Status: 
There are three (3) levels of licensing status for the Orion™ Software. 

• Tier 1 Will allow one (1) printer to be connected to the desktop and 
“Operator Mode” for a windows™ tablet. 

• Tier 2 Will allow unlimited printers to be connected to the desktop 
and tablet. 

• Tier 3 Will allow and unlimited number of printers to be connected 
to the desktop and include Database Server and AutoData 
Server functions. 

Licensed Printer List: 
The licensed printer list shows the printers that can be used by the current Orion 
Software License. 

To change (add or subtract) printers from the licensed printer list select the “Change” 
button. 

Check the boxes for all the printers to be licensed for network use and select “OK”. 
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Attention! A printer must be in the Licensed Printer List to be selected 
in “Send Message to Printer” dialog. 

 
License Number: 
There is a license number for the Orion Software Package located on the 
“DOWNLOAD INSTRUCTIONS” card that came with the CoPilot or Jetline 
printing systems. If you have purchased a license for multiple printers enter the 
number in the “License Number:” box. 
 

 
 
Activation Method 
There are two ways to activate the installed Orion Graphical Software Package. 
 
Automatic Activation: 
 

To automatically activate 
Orion, select the “Automatic 
Activation” radio button and 
the “Activate License” 
button. 
 
 
 
 
 
 
 

 

 
 
Manual Activation: 
 

To manually activate Orion, 
Select the Manual 
Activation radio button and 
call or fax the installation ID 
to Engage Technologies to 
get an unlock code. When 
you have received the 
unlock code, enter it in the 
Unlock Code: box and 
select the “Activate 
License” button. 
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File>Options 
Select “Options…” from the file drop down menu to set some default 
values for attached printers and to check for software updates. 
 

 
Attention! “Options” in the file drop down menu only set the default 

values for the connected printers such as a default font size 
or barcode type. “Options” does not configure the connected 
printers. 

 
System Options Window: General Tab 

 
 
Inkjet Printer default Font 

“Inkjet Printer Default Font” are the default font 
setting to be used when create text elements for 
piezo printers such as the Squid Ink CoPilot or 
AutoPilot printing systems. To change the default 
values use the drop down arrows for font, height 

and width. Select the “OK Button in the System Options window to apply the changes. 
 
DOD Printer Default Font 

“DOD Printer Default Font” are the default font 
settings to be used when create text elements for 
DOD printers such as the squid Ink Jetline printing 
system. To change the default values use the 

drop down arrow and select the desired dot matrix font. Select the “OK Button in the 
System Options window to apply the changes. 
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Barcode Defaults 
”Barcode defaults” are the default barcode 
attributes. To change the default values for 
barcode attributes input or use the drop down 
arrow for a list of attributes for the value you wish 
to change. Select the “OK Button in the System 
Options window to apply the changes. 

Check for Updates 
Occasionally software and/or firmware updates 
will become available from Squid Ink 
Manufacturing. Click on the “Check for updates…” 

button to update your printers and software. A “Check for Updates” window will open 
and display the current software and firmware levels. 

If there are updates available you will be asked if you want the updates. Follow the on 
screen prompts to apply the updates. 

Note: A warning will display if the user exports multiple updates to 
the same printer type. 
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System Options Window: Print Station/Message Tab 
The System Options Message tab contains default settings for displaying and saving 
messages. 
 

 
 
Message Edit 
”Message Edit” Check the boxes for the defaults you would like to apply here. 
 

 
 
 
Multiple substrate surfaces message View mode: 
 

Use the drop down arrow to set how 
you would like the view for multiple 
surfaces displayed. 
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Print Station/Message Storage Location 
”File Storage Location” is the location where message files will be saved. 
 

 
 

 
If “Default is selected files will be saved to the default location. The default location is 
C:\Squid Ink\Orion\Printnode\Messages. Orion will create a folder for each print station 
containing messages and a “DELETED” folder at this location. 
 

Tip! If a message has been accidently deleted it is possible to find and 
restore the deleted from the “DELETED” folder. 

 

 
 
If Alternate (local or remote) is selected a 
navigation window will open where you can select 
the desired location where message files will be 
saved. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Print Station/Message Export is used to transfer all print station and message data to 
another location. See the “Print Station/Message Data Transfer” section in this 
manual. 
 

 
Print Station/Message Import is used to retrieve all print station and message data from 
another location. See the “Print Station/Message Data Transfer” section in this 
manual. 
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System Options Window: Communications Tab 
Use the Communications window to set communication defaults. 

”Communication Defaults” are the default settings 
network printers will use to communicate. 
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System Options Window: Appearance 
Use the “Appearance tab to define the default settings for how the message will be 
displayed on screen. 
 

 
 
Ribbon Style: 
Use the drop down arrow to select a color for the message area background. 

 
 

Select “OK” and the selected color will be applied to the message area 
background. 

 
Load color from preset: 
Use the drop down arrow to select preset color definitions for the message area. 
 

   
 
Selecting preset definitions will override any custom color selections. Select “Yes” to 
continue. 
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Workspace Color 
The colors for selected areas in the message workspace can be changed here. 

Changing a color is very simple. To change a color, select a box for the area you would 
like to define and a color palate will open. For example, to change the display color for 
“Substrate”, select the Substrate box and the color palette will display. 

Using the Color Palette you can select from any number of colors or create a custom 
color. 

Select “OK” and the new color will be applied to the selected message 
area. 
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Element color 
You can change to color message elements are displayed in. 
 

 
 
Change an element color is very simple. Select the type of element you wish to change. 
A color palette will open. For example if you wish to change the color in which Date and 
Time are displayed select “Datetime”. 
 

 
 
Using the Color Palette you can select from any number of colors or create a custom 
color. 
 

Select “OK” and the new color will be applied to the selected element 
type. 
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Home 

The “Home” tab contains three groups: 

• Message

• Print Station

• Tools

Home>Message Group 

The Message section contains functions for managing messages created in the Orion 
Graphical Software Package. 

New 
Mouse clicking the ”New” icon will open the New Message 
window. 

In the “New Message” window you 
can select the print station, name 
the message and apply any existing 
templates. Select “OK” to open the 
new message. 
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Open 
Mouse clicking on the “Open” icon will allow you to find and open 
an existing message. 
 
 
 
 
 
 
 

 
 
The “Open Message” window will list all existing messages assigned to the selected 
print station. In the above example there are two messages listed under print station 
“Practice 1”. 
 
A preview of the selected message will be displayed on the right side of the Open 
Message window. 
 

Use the “Print Station:” drop 
down arrow to select a different 
print station. 
 
 
 

 
Select a message from the list and Mouse click on “OK” to open the selected message. 
Or double click on a message in the message list. You can select more than one 
message to open them at a time. 
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Open File 
Open an existing message from a disk file. Click on “Open File” and navigate to 
the file location to open the desired message. 
 
 
 

Save 
Clicking the “Save” icon will save any changes to the current 
message. Ensure that you really want to save the changes 
before clicking on “Save”. 
 
 
 
 
 
 

Save As 
”Save As” will allow you to save the current message under a 
different name. 
 
 
 
 
 
 
 

Enter the New name for the 
message in the “Message 
Name:” box and click “OK” to 
save the current message 
under a new name. 
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Close 
Clicking the “Close” icon will close the selected message. 
 
 
 
 
 
 
 

 
You will be prompted to save the changes 
before closing the message. Select “Yes” 
to save the changes before closing. Select 
“No” to close without saving. 
 
 
 
 

 
Send to Printer 

Send the open message to the printer. Selecting this icon will open the “Send 
Message to Printer” screen. 
 
 
 

 
 

Send to Printer Window 
 
Select the printer you wish to send the current message to and select “OK”. A progress 
screen will open. 
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Message Transfer Progress Window 
 
After the message has successfully transferred, select “Close” to close the progress 
screen. 
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Export to USB Disk 
“Export to USB Disk…” will save the current message on a removable USB 
disk. 
 
 
 

 

 
 

Export to USB Disk Window 
 

The “Reset” button will reset printers assigned as target printers to the 
message pre assigned printers. 

 
The “Add” and “Remove” buttons will move printers back and forth to the 
target list. Double clicking on a listed printer will also move the selected 
printer(s) to or from the Target printer list. 
 
 

 
The ”Printer Messages:” button will offer options for dealing with existing messages. 
Use the drop down arrow and select the desired option. 
 

 
 

Select the “OK” button to send the current message to the USB DSK. 
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Export to USB Disk Generic Printer: 
In the “Export To USB Disk” window there is an option to select “Generic Printer” at the 
top of the list of available printers. 
 

 
If “Generic Printer” is selected the 
message exported to the USB disk 
can then be walked around to any 
printer of the same type and loaded 
onto the printer. The message will 
not be tied to a specific printer ID. 
The Generic Printer option is 
available for JetLine and CoPilot 
printers. 
 
 
 
 
 

 
Message Management 

Message management provides a variety of functions such as Export, 
Import, Print, etc. for managing messages. 
 
 
 

Select “Message Management” to open the message management window. 
 

 
 

Message Management Window 
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Import: 
Select “Import” to import an existing Orion (xxxx.orion) message or an 
existing ImageMaster (xxxx.txt PZ Pilot) file. 

Note: Import will only support .txt files that were created in 
ImageMaster for the PZ Pilot/Pilot Plus printing system. 

To import a message, navigate to the message you would like to import and select 
“Open”. 

Import Window 
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Export: 
Select “Export” to export the current message to a selected directory. 
 

 

 
 

Browse for Folder Window 
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Email 
Use this to email the selected message. 

Tip! Email is a good tool for transferring messages because it will 
attach all the related elements, text, graphics, etc. included 
in the message to the email. 

Delete 
Use this to delete selected messages. You will be asked to confirm 
that you wish to delete the selected Message(s). 

Select “Yes” and the selected messages will be deleted. Select “No” to close the delete 
window without deleting the selected messages. 

Attention! The “Undue” button does not restore a deleted message. 
When the message it’s deleted it’s gone. 
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Export to USB Disk 
 “Export to USB Disk…” will save the current message on a removable 
USB disk. 

 

 
 

Export to USB Disk Window 
 
Export to USB Disk Generic Printer: 
In the “Export To USB Disk” window there is an option to select “Generic Printer” at the 
top of the list of available printers. 
 

If “Generic Printer” is selected the message 
exported to the USB disk can then be walked 
around to any printer of the same type and 
loaded onto the printer. The message will not 
be tied to a specific printer ID. The Generic 
Printer option is available for JetLine and 
CoPilot printers. 
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Send to Printer 
Send the open message to the printer. Selecting this icon will open 
the “Send Message to Printer” screen. 

 

 
 

Send to Printer Window 
 
Select the printer you wish to send the current message to and select “OK”. A progress 
screen will open. 
 

 
 

Message Transfer Progress Window 
 
After the message has successfully transferred, select “Close” to close the progress 
screen. 
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Home>Print Station Group 
 
The Print Station group contains functions for managing print stations and configuring 
printers that are assigned to the selected print station. A print station is not a printer. 
The print station is the location where printing will occur. Printers are added to print 
stations. 
 

 
 
Add Print Station 

To add a print station, click the “Add a Print Station” icon from the top menu 
bar.  
 
 
 
 

 
The “Print Station” dialog box will open. 

 
In the print station dialog box 
you can: 
 

• Give the print station a 
unique name. 

 
• Specify the substrate 

type. 
 

• Define the product 
dimensions. 

 
• Specify the surface(s) 

to be printed on. 
 

 
Specify the name of this Print Station: 

Use this box to give the print station a 
unique name. 
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Substrate Type: 
Use the drop down menu next to “Substrate Type” to 
select the type of substrate you will be printing on. 
 
 
Specify the product dimensions: 

Define the size of the product that will be 
printed on. The number of options will change 
according to the substrate type. For example 
a label will have no depth value. 
 
 
 

Dimensions can be in Inches, centimeters or millimeters. Use the drop 
down arrow to select the desired unit of measurement. 
 
 

 
Specify which surfaces(s) to print on: 

Check the box next to the surface to be 
printed on. The number of options will change 
according to the substrate type. For example 
a 2 side box will only have two surfaces, a 
front and back. 

 
Add a Substrate Surface 

Mouse click the “Add Substrate Surface” icon to add a printing surface to 
the print station. 
 
 
 

The “Substrate Surface” window will open. 
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Surface: 
Use the drop down arrow under “Surface” to select an already named 
surface to add to the print station. 
 
 
 
 

 
Print Direction: 

Use the drop down arrow under “Print Direction” to select the direction 
the surface will be traveling in. 
 

 
Substrate Surface Name: 

Here you can enter a unique name for the surface to 
be added to the print station. 

 
 
Substrate Size: 

 
 

Enter the width and height for the printing surface here. Size units can be 
inches, centimeters or millimeters. Use the drop down arrow to select the 
desired unit of measurement. 
 

 
Enable Bitmap Substrate 
Using a bitmap image as the substrate is useful if there is an existing piece of artwork or 
graphic that you would like to represent the printing surface on the Orion™ message 
creation screen. The bitmap image used as a substrate does not print. 
 
To use a bitmap image to represent the printing surface: 
 

Check the “Enable Bitmap Substrate” box. 
 

 
Mouse-click the “Browse” button. 
 

 
 
 
 



70   Menu Tabs 

When the browse window opens, navigate to the graphic location and select the desired 
image. 

In this example I’m going to use this image for the bitmap substrate. 

With the desired bitmap selected mouse-click on “Open”. 
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Select “OK” in the “Substrate Surface” window. 
 

 
 
The selected bitmap image will now display as a substrate surface. 
 

 
 

Example of a Bitmap Image Displayed as a Substrate 
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Print Area 
The “Top Margin” displays the distance from 
the top edge of the substrate to the top of the 
message. It is how the printhead position is 
shown on the Orion™ message creation 

screen. It is a visual aid to help in placing elements in the message. To set the top 
margin, enter the distance in the “Top Margin” box. 

Home>Tools Group 
Below is a general description of the tools found 
in the “Tools Group” under the “Home” tab. For 
more information on these tools see the specific 
section in this manual relating to the specific 
function. 
 

 
Operator Mode: 
Orion has the capability of entering a mode in which the user is locked out of most 
program functions except selecting message files, transferring them to the printer and 
some settings functions called the “Operator Mode”. This prevents unauthorized 
personnel from editing message information in error or creating undesirable messages. 
See the “Operator Mode” section in this manual for instructions on using Orion™ in the 
Operator Mode. 
 
Database Message Server: 
The Database Message Server is an Orion™ message creation function that is used to 
create dynamic messages from a template and sent to the printer(s). The message is 
populated with data retrieved from a predefined database table. See the “Database 
Message Server” section in this manual for using information from a database file when 
creating messages. 
 

Note: The Database Message Server option is only available in the 
Orion™ Tier Three License Level. 

 
Auto Data Server: 
An Auto Data Template message contains at least one Text, Barcode and/or Graphic 
element that is configured to accept Auto Data. When the message is initially loaded, 
the “Default Data” you enter for Text and Barcode elements or the graphic you use for 
Graphic elements will be printed as a placeholder. Once the printer receives an Auto 
Data record, it will rebuild the message, placing the various fields into their associated 
elements. See the “Auto Data Server” section in this manual for creating messages 
using Auto Data. 
 

Note: The Auto Data Server function is only available in the 
Orion™ Tier Three License level. 

 
Random Code: 
Random Code will create a batch of random codes and save it to a text file for printing. 
See the “Generating Random Code Files” section in this manual for instructions on 
creating random character codes. 
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View 
 
The “View” tab will open windows and provide functions for navigation and displays. 
 

 
 

View>Print Station Explorer 
 
Clicking the “Print Station Explorer” Icon will toggle the print station explorer 
panel. 
 
 
 

The print station explorer panel will display a list of all print 
stations we have defined on the left side of the Orion 
workspace. 
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View>Message Explorer 
 

Clicking the “Message Explorer” Icon will toggle the message explorer panel. 
The “Message Explorer” panel will display a list of all the elements contained in 
the current message defined in print station structure 
 
 

 
 

Message Explorer Panel for Current Message 
 

View>Printer Connections 
 
Mouse clicking the “Printer Connections” will toggle the “Printer Connection 
Status” panel along the bottom of the message display. The Printer Status 
Connection panel will display a list of printers registered in Orion. 
 
 

 
 

Printer Connection Status Panel 
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Printer Configuration Tab 
Double mouse clicking on a printer in the Printer Connection Status panel will open the 
Printer Configuration window for that printer in the Orion workspace. You can also open 
the configuration window for a selected printer by selecting the “Printer Configuration” 
icon for a highlighted printer in the print station explorer list. 

In this Printer Configuration window you can view or change settings for a printer. There 
are four tabs along the top of the Printer Configuration window. 

• General

• Font List & Ink System

• Network Configuration

• Print Configuration
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General 
 

 
 
The “General Tab will display information about the selected printing system. When a 
printer is connected, if there are firmware, software or any other updates available for 
the printer the “Install the latest version” will become active. 
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Font List & Ink System 
 

 
 
The Font List & Ink System window will display a list of the available or supported fonts 
and information pertaining to the ink system. 
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Network Configuration 

The Network Configuration window will show the current network configuration and 
allow changes. 

Generally the printer will be set to “Obtain an IP address automatically”. 

Select the “Use the following IP address:” radio button to manually select an IP address. 

Attention! Should you decide to manually input the IP address be sure 
to work hand in hand with the IT or System Administrator at 
your facility to avoid conflicting with existing devices that 
may be using the same address. 
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Print Configuration 
 

 
 
The “Print Configuration” Tab consists of two sections, the “Configure Printer” group and 
the “Configure Each Printhead” group. 
 
The “Configure Printer” group contains global settings for the selected printing system. 
 
The “Configure Each Printhead” group contains settings for each individual printhead. 
 
Speed Detection: 

Use the drop down menu next to “Speed Detection” to select “None” 
or “Encoder”. Select none if you are going to input the line speed 
manually. Select Encoder if you will be using an encoder to detect 
line speed. 

 
Speed (FPM): 

Use the up and down arrows next to “Speed (FPM):” to manually set 
the line speed. When manually inputting line speed be sure “Speed 
Detection” is set to none. Line speed is measured in Feet per Minute. 
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Encoder Divider: 
The encoder divider is currently set by the factory at 13. The 
encoder divider is not changeable. 

 
Encoder Time Out (seconds): 

The amount of time the encoder will remain idle and stop trying to 
send a signal. Use the up and down arrow buttons to increase or 
decrease the value. 

 
Encoder Resolution (PPR): 

Encoder Resolution has been set at the factory to correspond to the 
optional encoder that if ordered was shipped with the printer. The 
Encoder Resolution cannot be changed. 

 
Track Encoder Direction: 

Track Encoder Direction is set to “No” and cannot be changed. 
 

 
Encoder Rotation Direction: 

Only “Clockwise” is available. The rotation direction cannot be 
changed. 

 
Printhead #: 
Use the down arrow button to select which printhead to apply the configuration. 
Select printhead one or two. 

 
 
Distance to Photocell: 

The “Distance to Photocell” is the distance between the 
photocell and the printhead. Increase or decrease the distance 

to photocell by using the up and down arrows next to the distance to photocell box. Or, 
simply enter the desired distance in the box. 

 
Distance to photocell can be in inches, centimeters or millimeters. Use 
the drop down menu to select the desired unit. 
 
 

 
Direction of Substrate: 

The direction of substrate can be “Left to Right” or “Right to Left”. 
Use the drop down arrow to select the desired direction. 
 
 

Note: Substrate direction is considered when viewed from behind 
the printhead. 
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Printhead Rotation (degrees): 
The Printhead Rotation function has been disabled in the Orion 
Software Package. 

 
 
Spit Mode: 

When turned on the printhead will spit a small quantity of ink at pre-
determined intervals. The spit function is useful when printing with 
fast drying solvent based inks to keep the ink from drying and 
clogging in the ink nozzles. 
 

There are four spit modes. OFF, COLUMN, GHOST ALL and GHOST. 
 

OFF Turns the spit mode off. The printer will not spit when “OFF” is 
selected. When printing with oil based ink the spit should always 
be set to “OFF”. 

 
COLUMN Will spit a column of ink the entire height of the printhead at 

selected time periods. 
 

GHOST Will spit a small amount of ink through the nozzles that are not 
being used during printing. GHOST is useful if a long message only 
uses some of the nozzles in the printhead. 

 
GHOST ALL Will spit a small amount of ink through all the printhead nozzles all 

the time even during printing. GHOST ALL is useful when printing 
with very fast drying inks. 

 
Spit Quantity (columns): 

Defines the quantity of the spit mode by selecting the number of 
columns the printhead will spit each time. Use the up and down 

arrows to select a value or type in the desired number. 
 
Spit Period (seconds): 

The “Spit Period” in Seconds is the time between spits. Use the 
up and down arrows to select a value or enter the desired value. 

 
Spit Delay (milliseconds): 

The “Spit Delay” is the time in milliseconds between when the 
message stops printing and the spit will begin. 

 
Time Out (HH:MM:SS): 

The “Spit Timeout” is when the printer will quit spitting. This is 
important if the printer is going to be abandoned for a period of 

time such as overnight or long break. 
 
Spit Trigger: 

The “Spit Trigger is not changeable. The spit trigger will always 
be the end of printing the current message. 
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Printer Configuration>Tools Tab 
 
When the printer configuration window is open there is a Tools Tab present. Residing in 
the Tools Tab is a ribbon of tools that contain several important printer and printhead 
functions. 
 

 
 

Configuration Group 

 
 
Reload: 

Reload the print configuration from the selected printer. 
 
 
 
 
 

When reload is selected a window 
will open asking if you really want to 
reload the print configuration from 
the printer. Select “Yes” to reload 
the configuration from the selected 
printer. 
 
 
 

 
Save & Apply the Configuration: 

Select this icon to save and apply the configuration changes for the selected 
printer in Orion. 
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Tools Group 

Start Printing: 
Use to tell the printer to start printing. 

Stop Printing: 
Use to tell the printer to stop printing. 

Purge and Fill: 
Purging and filling is done at the printer. The Purge and Fill functions are 
not available at the desktop. They are represented in Orion to 
accommodate future expansion. 

File Clean: 
Selecting “File Clean” will delete all the message files residing in the selected 
printer. 

When “File Clean” is selected you 
will be advised that all the 
message files residing on the 
selected printer will be deleted. 
Select “Yes” to clean all the 
message files from the printer. 

Note: ”File Clean” will only remove message files from the selected 
printer. It does not delete files from the desktop or other 
printers that may be in the same print station or on the same 
network. 
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Custom Keyboard: 
Use to customize a printer’s on screen keyboard to input User Data. See 
the “User Data > Custom Keyboards” section of this manual to see 
instructions for creating a custom keyboard. 
 
 
 
 

 
Sync. Date/Time 

Synchronize printer Date/Time to system current date/time. 
 
 
 
 
 

 
Start/Stop Operator Mode: 

Start or Stop Operator mode of the printer controller. 
 
 
 
 
 

 
Reset Calibration: 

This button is used to calibrate the touch screen on the CoPilot or JetLine 
Controller. The graphics on the controller touch screen normally won’t be 
out of sync with the corresponding functions however if you are having 
problems selecting icons recalibrating the touch screen may help 
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Status Group 
 

 
 
Production Counter: 

The production counter will show the current number of prints. 
Selecting “Reset to 0” will reset the production counter to zero. 
 
 

 
When “Reset to 0” is selected you 
will be advised the printer counter 
will reset. Select “yes” to reset the 
production counter to zero. 
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Message Tabs 
 
 
Message contextual tabs will appear when there’s a message open in the Orion 
workspace and currently selected. This contextual tab contains three sub tabs. The 
“Message” tab is used for managing the current message such as saving and sending 
the message to the printers. It also contains functions to manipulate multiple selected 
elements. 
 
The “Insert” tab is used to insert elements such as text, barcodes, and graphics into the 
message. 
 
If an element in the current message is selected the “Properties” contextual tab will 
display. In the properties ribbon you can view and modify properties for the single 
selected element. 
 

Message 
 

 

Message Tab>New 
“New” will open a new message creation window. 
 
 

Message Tab>Open 
“Open” is for opening and existing message that has been created in Orion. 
 
 

Message Tab>Save 
Select “Save” to save changes to the current message. 
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Message Tab>Save As 
Select “Save As” to save the current message with a different name. 

Message Tab>Close 
Select “Close” to close the current message. After selecting “Close” you will 
be asked if you want to save the changes for the message before closing. 

Message Tab>Send To Printer 
”Send To Printer…” will send the current message to the 
connected printers for printing. The “Send Message to Printer” 
window will open. 

Send Message To Printer Window 



88   Menu Tabs 

The “Send Message To Printer” window will list all the printers assigned to the message 
being sent on the left. On the right side of the window additional connected printers are 
listed. 

The “Reset” button will reset printers assigned as target printers to the 
message pre assigned printers. 

The “Refresh” button will update the list of connected printers available 
to add to the message target. 

The direction buttons will move printers back and forth to the target list. 
Double clicking on a listed printer will also move the selected printer(s) to or 
from the Target printer list. 

Click the “OK” button to send the current message to the target printers. 

If you have made changes to the current message you will be asked if you want to save 
before sending the message to the assigned printers. 
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Message Tab>Export To USB Disk 
“Export To USB Disk…” will save the current message on a 
removable USB disk. 

Export To USB Disk Window 

The “Reset” button will reset printers assigned as target printers to the 
message pre assigned printers. 

The “Add” and “Remove” buttons will move printers back and forth to the 
target list. Double clicking on a listed printer will also move the selected 
printer(s) to or from the Target printer list. 

The ”Printer Messages:” button will offer options for dealing existing messages. Use the 
drop down arrow and select the desired option. 

Select the “OK” button to send the current message to the USB DSK. 
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Message Tab>Ink Usage 
Clicking the “Ink Usage” icon will open a display that will estimate the number of prints 
you may expect from an ink can or cartridge. 

The ink usage is shown as the maximum number of prints you may expect to get if 
100% of the ink in the can or cartridge is used for printing. The message as it looks on 
screen at the time of ink usage request is the image used for calculation. Factors such 
as spitting and/or priming will reduce the number of prints to some degree. Also, any 
variable data, AutoData, or user data that will print significantly different length text 
strings will affect the calculation accordingly. 

Message Tab>Clipboard Group 
This group contains tools for undoing and redoing changes, 
as well as “Cut”, “Copy” and “Delete”. 

Message Tab>Arrange Group 
This group contains tools for aligning, automatically spacing and 
locking elements. 
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 Message Tab>Element Group 
This group contains options for hiding an element so that it does not get 
printed, inversing the element (background is printed instead of the 
element) and inverting the element (turning it upside down). These 
options only affect the selected element(s). Check the appropriate box to 
apply the action to the selected element(s). 
 

 

Message Tab>Printhead Group 
This group contains printhead-level tools such as inversing 
and inverting the entire currently selected printhead in the 
message. 
 
 
 

 

 
Enable or disable print of the selected printhead. Currently “Enable” is always selected 
and cannot be unchecked. 
 

 
Inverse Print will print the highlighted printhead’s background instead of the content. 
 

 
Print content of the highlighted printhead will print upside down (flip vertically). 
 

 
The number of times each column of data will be repeated making the print that much 
wider (or bolder). Use the up and down arrows to increase or decrease the number of 
hits or enter the desired value in the Hits box. 
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Message Tab>Printer Group 
This group contains printer-level tools such 
as Pre Build, Repeat Print mode and if there 
is a database associated with the message. 
 
 
 

 
Database Connection: 
Use Database Connection if the message is populated with data retrieved 
from a predefined database table. See the “Database Server” section in this 
manual for instructions on including information received from a database in 
the message. 
 

 
Database Field Preview: 

Database field Preview will display the database table associated with the 
current message. 
 
 

 

 
 
  Example of Database Field Preview 
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Share Counters: 
Share the same set of counters between all the printheads. Any change 
taking place in the counter on one head will be reflected on the other head. 
 
 
 
 

“Share Counters” is toggled off and on by selecting the “Share Counters” Icon. 
 

While the “Share Counters” Icon is highlighted “Share Counters” is active. 
 
 
 

 
When the “Share Counters” Icon is not highlighted “Share Counters” is inactive. 
 
 
 

 
Note: If there is an unequal number of counters on the printheads 

(for example three counters on printhead one and two 
counters on printhead two) only the lower number of 
counters will sync. 

 
 
One Shot Mode: 

One Shot Mode is an Auto Data function only. See the “Auto Data” 
section in this manual for instructions on selecting One Shot Mode. 

 
 

Repeat Mode: 
When a message is configured for Repeat Mode, it will be printed 
repeatedly as long as the trigger is active. Repeat Mode is often 

used when printing on long substrates and extruded material. 
 

In Continuous Line Mode the printer will only build the message when the 
printer is triggered. This will eliminate any gap between repeats caused by 
the printer not being able to print while rebuilding the message. Do not use 
this mode if the message contains variable data and you want the data to 
update when repeating. 

 
If not in “Continuous Line Mode” length, unit, and quantity options are available to define 
the repeat parameters. 
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The Length specifies how often the message is repeated (based on 
the selected Unit). In order to print a continuous line, you have to 

set the Repeat Length to 1 column longer than the length of data being printed. This 
causes the printer to repeat as soon as it’s finished the first print. Orion™ simply sets 
the required values eliminating the need to figure out how long the message is and what 
the Length value should be. 

Use the drop down menu to select the desired unit for the repeat 
length. 

The Quantity specifies the total number of times this message is to 
be repeated. Use the up and down arrow keys or enter the desired 

value in the QTY: box. Enter a Zero (0) to theoretically repeat forever. 
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Inserting Elements in a Message 
 
 
The “Insert” tab contains tools for adding various types of elements to the message. 
Elements can be inserted into the message by selecting the element icon in the “Insert” 
ribbon or right mouse clicking in the message and selecting the element from the drop 
down menu. 
 

 
 

 
 
 

Text/Barcode Element Group 
 
This group contains tools for adding Text, Date, Time, Shift, Counter, and Barcode 
elements to the message. 
 

Text 
To place a text string in the message select the “Text” icon under the “Insert” 
tab or right mouse click in the message area and select “Create Text Here” 
from the drop down menu. 
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When a text element is inserted the text properties contextual ribbon tab will be 
displayed for the selected text. Here you can change the element’s attributes. 
 

 
 

Text Properties Tab 
 

ID/Position 
This group displays the ID assigned to the text and the current position 
in the message. You can use the up and down arrow in the “X” and “Y” 
position boxes to move the selected text vertically and/or horizontally in 
the message. Unless you are really trying to fine tune the location it is 
much more convenient to simply click and drag the text element to the 
desired position. 

 
Rotation 

This group allows the selected text to be rotated to 90, 180, or 270 
degrees. The Default is “0” Zero degrees. 
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Font 
In the font group you can define most of the 
properties for the current text. Such as font, 
size, bold, underline. 
 
 
 

 
Type: 
 

The type box will define the font to be printed. Use the drop down arrow to display a list 
of available fonts. Use the scroll arrows in the side bar to move through the list of 
available fonts. 
 

   
 
Notice that the Dot Matrix (Jetline) list is much different than the Hi-Resolution (CoPilot) 
list. 

 
Height: 
 

Use the height box to select the desired height for the selected text. 
Click on the down arrow in the “Height” box to display a list of font 
heights. Text height is available for the selected Hi Resolution CoPilot 
text. Not available for Dot Matrix text. Height is measured in the number 
of printhead jets. 
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Font Characteristics: 
 

Use the following symbols to assign values to a selected piece of text. 

 
Character Spacing: 
 

Adjust the space between characters. Use the up and down arrows to increase or 
decrease the space between characters. Default character spacing is “0” Zero. 
 

Line Spacing: 
 

Adjust the amount of space between lines. Use the up and down arrows to increase or 
decrease the space between multiple lines of text. Line spacing is increased or 
decreased by number of nozzles. If the lines of text are already using all the printhead 
nozzles the space between lines cannot be increased. Default line spacing is “0” Zero. 
 

Font Width: 
 

Use the down arrow to select a font width. The default font width is “1” one. 
Please be aware that changing the font width will significantly change the 
length of the selected text string. 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Make Selected 
Text Bold 

Italicize the 
Selected Text 

Underline the 
Selected Text 

Strikethrough 
Draw a Line 
Through the 
Selected Text 

Grow the 
Selected Text 

Shrink the 
Selected Text 
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Text Input Box: 
 

Enter Text Box: 
In this box enter the text to be printed. 
 

 
New Line Button: 
 
 

If you wish to include more than one line of text select the 
New Line icon in the text group to wrap the text string 
without placing it in the message. 

 
Embed: 
 

Items such as date, time, shift, etc. can be embedded into a text string element. 
 

Use the drop down arrow in the “Embed” box to display a list 
of items that may be embedded in the text string element. 
 
 
 
 
 

Click the paper clip icon to embed the selected item 
into the text string. 

 
Here is an example of a time element embedded in a text string. 
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Paragraph 
Use the tools in the Paragraph group to 
justify multiple lines of text. Select Left, 
Center, or Right to apply. 

Dynamic Data 
Dynamic Data will allow data from and outside source such as a data 
base or spread sheet to be placed in the message. 

Allows a selected text string to be replaced by the user each time the 
message is sent to the printer. See the “User Data” section in this 

manual for information on text with user data. 

Auto Data is not available. 

Database Field is not available. 



Inserting Elements in a Message   101 

Date 
To insert a date in the message click on the “Date” icon or right mouse click in 
the message area where you would like to place the date and select “Create 
Date Here” from the drop down menu. 
 
 

 
 
When you insert a date, the Date “Properties” ribbon will be displayed. 
 

 
 

Date Properties Tab 
 
ID/Position 

This group displays the ID and the current position of the selected date 
element in the message. You can use the up and down arrow in the “X” 
and “Y” position boxes to move the selected element vertically and/or 
horizontally. Unless you are really trying to fine tune the location it is 
much more convenient to simply click and drag the text element to the 
desired position. 

 
Rotation 

This group allows the selected date element to be rotated to 90, 180, or 
270 degrees. The Default is “0” Zero degrees. 
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Font 
In the font group you can define most of the 
properties for the current text. Such as font, 
size, bold, underline. 
 
 
 

 
Type: 
 

The type box will define the font to be used in the date text string. Use the drop down 
arrow to display a list of available fonts. Use the scroll arrows in the side bar to move 
through the list of available fonts. 
 

   
 
Notice that the Dot Matrix (Jetline) list is much different than the Hi-Resolution (CoPilot) 
list. 

 
Height: 
 

Use the height box to select the desired height for the selected text. Click on the down 
arrow in the “Height” box to display a list of font heights. Text height is available for the 
selected Hi Resolution CoPilot text. Not available for Dot Matrix text. Height is 
measured in the number of printhead jets. 

 
Font Characteristics: 
 

Use these Icons to select values for the date text string, Bold, underlined, etc. 
 

Character Spacing: 
 

Adjust the space between characters. Use the up and down arrows to increase or 
decrease the space between characters. Default character spacing is “0” Zero. 
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Font Width: 
 

Use the down arrow to select a font width. The default font width is “1” one. 
 
Date/Time 

Date/Time Format: 
 
Use the down arrow key in the Date format box to select how the 
date will display. Default is MM-DD-YYYY. 
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Time 
To insert a time element in the message click on the “Time” icon or right mouse 
click in the message area where you would like to place the time element and 
select “Create Time Element Here” from the drop down menu. 
 
 

 
Or right mouse click in the message area where you 
would like to place the date and select “Create Time 
Here” from the drop down menu. 
 
 
 
 
 
 
 
 

When the time element is selected or inserted the Time properties ribbon will display. 
 

 
 

Time Properties Tab 
 
ID/Position 

This group displays the ID and the current position of the selected time 
element in the message. You can use the up and down arrow in the “X” 
and “Y” position boxes to move the selected time element vertically 
and/or horizontally. 
 
 

Rotation 
This group allows the selected time element to be rotated to 90, 180, or 
270 degrees. The Default is “0” Zero degrees. 
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Font 
In the font group you can define most of the 
properties for the current text used for the 
time element. Such as font, size, bold, 
underline etc. 
 
 

 
Type: 
 

The type box will define the font to be used in the time text string. Use the drop down 
arrow to display a list of available fonts. Use the scroll arrows in the side bar to move 
through the list of available fonts. 
 

   
 
Notice that the Dot Matrix (Jetline) list is much different than the Hi-Resolution (CoPilot) 
list. 

 
Height: 
 

Use the height box to select the desired height for the selected text. Click on the down 
arrow in the “Height” box to display a list of font heights. Text height is available for the 
selected Hi Resolution CoPilot text. Not available for Dot Matrix text. Height is 
measured in the number of printhead jets. 

 
Font Characteristics: 
 

Use these Icons to select values for the time text string, Bold, underlined, etc. 
 

Character Spacing: 
 

Adjust the space between characters. Use the up and down arrows to increase or 
decrease the space between characters. Default character spacing is “0” Zero. 
 

Font Width: 
 

Use the down arrow to select a font width. The default font width is “1” one. 
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Date/Time 
Date/Time Format: 
 
Use the down arrow key in the time format box to select how the 
time will display. Default is HH NN SS A. 
 
A = A.M. 
 
P = P.M 
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Custom Date/Time Configuration 
With a date or time selected, mouse click on the “Custom Date/Time 
Configuration” Icon in the Date/Time Ribbon. This will open the “Custom 
Date Editor” window. 

The “Custom Date/Editor” allows the user to customize how the date and time will 
appear in the message. 

Period: 
Input a customized string to print for a one 
letter or two letter time period (before and 
after noon). 
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Weekday: 
One character, 3 character and a long weekday 
name can be customized. Also the first day of the 
week and first week of the year can changed for 
special case. 
 
 
 
 
 
 
 
 
 

 
 

Month: 
One character, 3 character and a long 
month name can be customized. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Preset: 
Use the drop down arrow in the “Preset” 
box to display a list of available time/date 
configurations. 
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Digit Replacement: 
To change a digit display, enter the new digit in the corresponding 
box and enable the desired field. For example to have the digit “0” in 
a time element print as the letter “A” in a time element it would look 
like this. 

Changes made in the “Custom Date Editor” can be saved by selecting 
the “Save as Default” button after the changes are made. The saved 

configuration will become the “User Saved Default” for Date and Time for later use. 
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Shift 
Select the “Shift” icon or right mouse click in the message and select “Create 
Shift Here” to insert a shift element and print a shift code in the message. 
 
 
 
 

 
 

 
 
In the shift group you can modify the shift properties. 
 

Total Shifts: 
Use the drop down arrow in the “Total Shifts” box to select the 

total number of shifts. In this example four (4) shifts have been selected. 
 

 
 

Time 1: 
Use the Up and Down arrows in the time box to 

select a time to start shift one (1). 
 

Use the up and down arrow keys to select times for 
the remaining shifts, two, three and four. 
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In the shift name box you can set the text that will print 
for the shift. The shift name is limited to 32 characters. 
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Counter 
Select the “Counter” icon or right mouse click in the message area where you 
would like to place the counter element and select “Create Counter Here” to 
add a counter element to the message  
 
 

 
 

 
 
In the counters group you can define parameters for the selected counter. 
 

Type: 
Define the counter type that will print in the selected counter 
element. 
 
Use the drop down arrow in the “Type” box to define the type of 
counter that will print. 

 
• Numeric: Print the counter value as a number(consists of ‘0’ – ‘9’) 

 
• Alpha: Print the counter value as alphabetic string (consists of ‘A’ – ‘Z’) 

 
• Alpha Numeric: Print the counter value as combination string of digits and letters. 

(consists of ‘0’ – ‘9’ and ‘A’ – ‘Z’) 
 

Trigger: What causes the counter to change, for example when the 
photocell is interrupted. If more than one counter has been defined 

in the message, the other counter can be a selected as trigger as well. 
 

Direction: 
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Use the down arrow in the “Direction” box to select the direction the counter will change, 
up or down. 
 

Start: 
 

Use the up and down arrows or input directly in the “Start” box to set a starting value for 
the selected counter. 

 
Stop: 
 

Use the up and down arrows or input directly in the “Stop” box to set a stop counting 
value for the selected counter. When stop value reaches, the counter will reset and 
begin counting at the assigned start value. 
 

Current: 
 

Use the up and down arrows or input directly in the “Current” box to set a current value 
for the selected counter. 
 

Step: 
 

Use the up and down arrows to select a step value for the counter. The default step 
value is one (1). 
 

Padding: 
Use the down arrow to select a Zero (0) or none as a place holder in the counter. 
 

Note: Padding selection will be disable when the counter format is 
Alpha. 

 

  
 

Selected counter with Padding Zero. 
 

Align: 
 

Use the drop down menu in the “Align” box to select left, center or right to 
align the counter digit.  
 
 
 
 

Note: Align will be disabled when padding=0 and the format is not 
Alpha Numeric. 
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Recall: 
Check the “Recall” to start the counter with the current value 

instead of the start value. 
 
 

Daily Counter: 
Check the Daily Counter Box to instruct the counter to reset to the 
start value at the specified Reset Time. Use the up and down 

arrows in the “Reset Time” box to specify a reset time. 
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Barcodes 
Select the “Barcode” icon or right mouse click in the message and select 
“Create Barcode Here” to add a barcode element to the message. 
 
 
 
 

 
 
The properties tab for the selected barcode will display. 
 

 
 

Barcode Properties Tab 
 
ID/Position 

This group displays the ID and the current position of the selected 
barcode. You can use the up and down arrow in the “X” and “Y” 
position boxes to move the selected element vertically and/or 
horizontally. 
 
Tip! Unless you are really trying to fine tune the location it is much 
more convenient to simply mouse click and drag the selected 
barcode element to the desired position. 
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Text Group 
Use the “Text” group to enter the text string and Embed 
elements in the selected barcode. 
 
 
 
 

 
Embed: 
 

Items such as text, date, time, shift, etc. can be embedded into a barcode text string 
element. 

 
Use the drop down arrow in the “Embed” box to display a list 
of items that may be embedded in the text string element. 
 

Click the paper clip icon to embed the selected item 
into the text string. 
 

Here is an example of a text element “Speedball Alice” embedded in a text string. 
 

 
 

Barcode with Embedded Text Element 
 

 

Enter Data for 
Barcode Here 
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Barcode Group 
Use the “Barcode Group” 
to define the barcode 
attributes. 

Symbology: 
Use the drop down arrow in the symbology box to select 
the type of barcode element. Use the scroll bar in the drop 

down list to find the desired barcode type. The barcode types appear in alphabetical 
order in the drop down list. 

Tip! Using the mouse, hover over a barcode in the 
symbology box or in the message and a description 
of the barcode will display. 
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Available 1D Barcodes 
 
Codabar Codabar 
Code128 Code 128 
Code39 Code 39 
Ean8 EAN-8 
Ean8CCA EAN-8 CC-A 
Ean8CCB EAN-8 CC-B 
Ean13 EAN-13 
Ean13CCA EAN-13 CC-A 
Ean13CCB EAN-13 CC-B 
GS1128 GS1-128 
GS1128CCA GS1-128 CC-A 
GS1128CCB GS1-128 CC-B 
GS1128CCC GS1-128 CC-C 
GS1DataBarExpanded GS1 DataBar Expanded 
GS1DataBarExpandedCCA GS1 DataBar Expanded CC-A 
GS1DataBarExpandedCCB GS1 DataBar Expanded CC-B 
GS1DataBarExpandedStacked GS1 DataBar Expanded Stacked 
GS1DataBarExpandedStackedCCA GS1 DataBar Expanded Stacked CC-A 
GS1DataBarExpandedStackedCCB GS1 DataBar Expanded Stacked CC-B 
GS1DataBarLimited GS1 DataBar Limited 
GS1DataBarLimitedCCA GS1 DataBar Limited CC-A 
GS1DataBarLimitedCCB GS1 DataBar Limited CC-B 
GS1DataBarOmnidirectional GS1 DataBar Omnidirectional 
GS1DataBarOmnidirectionalCCA GS1 DataBar Omnidirectional CC-A 
GS1DataBarOmnidirectionalCCB GS1 DataBar Omnidirectional CC-B 
GS1DataBarStacked GS1 DataBar Stacked 
GS1DataBarStackedCCA GS1 DataBar Stacked CC-A 
GS1DataBarStackedCCB GS1 DataBar Stacked CC-B 
GS1DataBarStackedOmnidirectional GS1 DataBar Stacked Omnidirectional 
GS1DataBarStackedOmnidirectionalCCA GS1 DataBar Stacked Omnidirectional CC-A 
GS1DataBarStackedOmnidirectionalCCB GS1 DataBar Stacked Omnidirectional CC-B 
GS1DataBarTruncated GS1 DataBar Truncated 
GS1DataBarTruncatedCCA GS1 DataBar Truncated CC-A 
GS1DataBarTruncatedCCB GS1 DataBar Truncated CC-B 
Interleaved2of5 Interleaved 2 of 5 
Itf14 ITF-14 
Msi MSI 
Scc14 SCC-14 
Sscc18 SSCC-18 
UpcA UPC-A 
UpcACCA UPC-A CC-A 
UpcACCB UPC-A CC-B 
UpcE UPC-E 
UpcECCA UPC-E CC-A 
UpcECCB UPC-E CC-B 
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Available 2D Barcodes 
 
DataMatrix DataMatrix 
GS1DataMatrix GS1 DataMatrix 
Pdf417 PDF417 
CompactPdf417 Compact Pdf417 
MacroPdf417 Macro Pdf417 
MicroPdf417 Micro PDF417 
MicroQRCode Micro QR Code 
QRCode QR Code 
 
 

Text Position: 
Use the drop down menu in the Text Pos.: box to select 

where the human readable text will be placed. 
 

“None” no human readable text printed. 
 
“Below Center” will center the text under the barcode. 
 
“Below Left” will align the human readable text left. 
 
“Below Right” will align the human readable text right. 
 

 
 
Height: 
 

Use the drop down arrow to select a barcode height. Barcode height is 
measured in printhead jets. 128 jets is the full printhead height. 
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Text Height: 

Use the drop down list in “Text Height” to select a text height for the human 
readable text in the barcode. Keep in mind the size of the human readable text 
will be subtracted from the overall barcode size. For example, if the barcode 
size is 96 jets and text height is 24 jets the barcode will be 72 jets. 

Ratio: 

Ratio sets the ratio of wide bars to narrow bars. 

Narrow Bar: 

The width in print columns of the narrowest bar (or module in the case of 
DataMatrix and QR code). Use the down arrow in the “Narrow Bar” box to 
change the value. This can also be adjusted by using the left or right selection 
handles of a barcode object. 

Spread Factor: 

This setting tries to compensate for ink spread, or dot gain, on certain 
substrates, such as some corrugated boxes, for example. Use the up and down 
arrows in the “Spread Factor” box to change the values. Experiment with higher 
values when your ink is spreading to improve the scan-ability of a barcode. 
Zero means no spreading. This setting only applies to certain types of 
barcodes. 
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Dynamic Data 
 

Dynamic Data will allow data from and outside source such as a 
data base or spread sheet to be placed in the message. 
 
 
 
 
 
 

 
 

Allows selected barcode data to be replaced by the user each time the 
message is sent to the printer. See the “User Data” section in this 
manual for information on barcode user data. 

 
Auto Data allows the selected text to be replaced by text from a 
computer. See the “Auto Data” “Auto Data Server” sections in this 
manual for instructions on using Auto Data. 

 
 

Database Field will allow the selected text to be replaced by 
information read from a database. See the “Database Message 
Server” section in this manual. 
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Barcodes Containing Application Identifiers: 
 
Entering the “ !̂” characters means “an “Application Identifier” (AI) follows. If the AI is 
understood by Orion and the printer and it specifies a fixed amount of data, another AI 
may be entered without adding another “ !̂” to the data string. 
 

Note: Orion™ will add a check digit to barcodes under the “01” 
identifier. Enter thirteen (13) digits for these barcodes and 
Orion™ will add a check digit automatically fulfilling the 
fourteen digit requirement. Do not enter fourteen (14) digits. 

 
Here are some examples to show how to create various GS1-128 barcodes. All of these 
examples are created by setting the Barcode Type to Code 128 in Orion. 
 

 
 
Barcode Data String: ^!0012345678901234567 
Output from scanner: 00123456789012345675 
The AI of 00 indicates this is a Serial Shipping Container Code (SSCC-18) consisting of 
18 digits (123456789012345675). The “5” at the end is a check digit. It is added 
automatically. 
 

 
 
Barcode Data String: ^!011234567890123 
Output from scanner: 0112345678901231 
The AI of 01 indicates this is a Shipping Container Code (SSCC-14 consisting of 14 
digits (12345678901231). The “1” at the end is a check digit. It is added automatically. 
 

 
 
Barcode Data String: ^!1108041017081010 
Output from scanner: 1108041017081010 
The AI of 11 indicates the Production Date in YYMMDD format (April 10, 2008) and the 
AI of 17 indicates the Sell by Date in YYMMDD format (October 10, 2008). Since the AI 
of 11 was understood by Orion and the printer, the AI 17 is automatically understood 
without having to add the ^! Before it. 
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Barcode Data String: ^!3104102500 
Output from scanner: 3104102500 
The AI of 310x indicates the Production Net Weight in kg, the fourth digit of the AI 
indicates where the decimal should be placed (number of positions from the right). In 
this example, the weight is 10.2500 kg. 
 

 
 
Barcode Data String: ^!400PO12345^!8002123ABC456DEF 
Output from scanner: 400PO123458002123ABC456DEF 
The AI of 400 indicates the Customer Purchase Order Number (PO12345) and the AI of 
8002 indicates the Electronic Serial Number (ESN) for Cellular Phones 
(123ABC456DEF). Since the AI of 400 is not understood by Orion or the printer, the ^! 
Characters need to be added before the next AI so that the 8002 will be placed in 
parenthesis. 
 
On the following pages is a complete list of application identifiers. 
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GSI 128 Application Identifier Values 
 

AI Description Data Format 

00 Serial Shipping Container Code(SSCC-18) 18 digits - numeric 

01 Shipping Container Code (SSC) 14 digits - numeric 

02 Number of containers 14 digits - numeric 

10 Batch Number 1-20 alphanumeric 

11 Production Date 6 digits: YYMMDD 

12 Due Date 6 digits YYMMDD 

13 Packaging Date 6 digits: YYMMDD 

15 Sell by Date (Quality Control) 6 digits: YYMMDD 

17 Expiration Date 6 digits: YYMMDD 

20 Product Variant 2 digits 

21 Serial Number 1-20 alphanumeric 

22 HIBCC Quantity, Date, Batch and Link 1-29 alphanumeric 

23n Lot Number 1-19 alphanumeric 

240 Additional Product Identification 1-30 alphanumeric 

250 Second Serial Number 1-30 alphanumeric 

30 Quantity Each Variable up to 8 digits 

310y Product Net Weight in kg 6 digits 

311y Product Length/1st Dimension, in meters 6 digits 

312y Product Width/Diameter/2nd Dimension, in meters 6 digits 

313y Product Depth/Thickness/3rd Dimension, in meters 6 digits 

314y Product Area, in square meters 6 digits 

315y Product Volume, in liters 6 digits 

316y product Volume, in cubic meters 6 digits 

320y Product Net Weight, in pounds 6 digits 

321y Product Length/1st Dimension, in inches 6 digits 

322y Product Length/1st Dimension, in feet 6 digits 

323y Product Length/1st Dimension, in yards 6 digits 

324y Product Width/Diameter/2nd Dimension, in inches 6 digits 

325y Product Width/Diameter/2nd Dimension, in feet 6 digits 

326y Product Width/Diameter/2nd Dimension, in yards 6 digits 

327y Product Depth/Thickness/3rd Dimension, in inches 6 digits 

328y Product Depth/Thickness/3rd Dimension, in feet 6 digits 

329y Product Depth/Thickness/3rd Dimension, in yards 6 digits 

http://www.gs1-128.info/ai-values
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AI Description Data Format 

330y Container Gross Weight (Kg) 6 digits 

331y Container Length/1st Dimension (Meters) 6 digits 

332y Container Width/Diameter/2nd Dimension (Meters) 6 digits 

333y Container Depth/Thickness/3rd Dimension (Meters) 6 digits 

334y Container Area (Square Meters) 6 digits 

335y Container Gross Volume (Liters) 6 digits 

336y Container Gross Volume (Cubic Meters) 6 digits 

340y Container Gross Weight (Pounds) 6 digits 

341y Container Length/1st Dimension, in inches 6 digits 

342y Container Length/1st Dimension, in feet 6 digits 

343y Container Length/1st Dimension in, in yards 6 digits 

344y Container Width/Diameter/2nd Dimension, in inches 6 digits 

345y Container Width/Diameter/2nd Dimension, in feet 6 digits 

346y Container Width/Diameter/2nd Dimension, in yards 6 digits 

347y Container Depth/Thickness/Height/3rd Dimension, in inches 6 digits 

348y Container Depth/Thickness/Height/3rd Dimension, in feet 6 digits 

349y Container Depth/Thickness/Height/3rd Dimension, in yards 6 digits 

350y Product Area (Square Inches) 6 digits 

351y Product Area (Square Feet) 6 digits 

352y Product Area (Square Yards) 6 digits 

353y Container Area (Square Inches) 6 digits 

354y Container Area (Square Feet) 6 digits 

355y Container Area (Square Yards) 6 digits 

356y Net Weight (Troy Ounces) 6 digits 

360y Product Volume (Quarts) 6 digits 

361y Product Volume (Gallons) 6 digits 

362y Container Gross Volume (Quarts) 6 digits 

363y Container Gross Volume (Gallons) 6 digits 

364y Product Volume (Cubic Inches) 6 digits 

365y Product Volume (Cubic Feet) 6 digits 

366y Product Volume (Cubic Yards) 6 digits 

367y Container Gross Volume (Cubic Inches) 6 digits 

368y Container Gross Volume (Cubic Feet) 6 digits 

369y Container Gross Volume (Cubic Yards) 6 digits 
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AI Description Data Format 

37 Number of Units Contained 1-8 digits

400 Customer Purchase Order Number 1-29 alphanumeric

410 Ship To/Deliver To Location Code (EAN13 or DUNS code) 13 digits 

411 Bill To/Invoice Location Code (EAN13 or DUNS code) 13 digits 

412 Purchase From Location Code (EAN13 or DUNS code) 13 digits 

420 Ship To/Deliver To Postal Code (Single Postal Authority) 1-9 alphanumeric

421 Ship To/Deliver To Postal Code (Multiple Postal Authority) 4-12 alphanumeric

7001 Nato Stock Numbers 13 digits 

7002 UN/ECE Meat Carcasses and cuts classification Variable up to 30 

7003 Expiration Date and Time 10 digits 

7004 Active Potency Variable up to 4 

703n Processor approval (with ISO country code); n indicates 

sequence number of several processors 

Variable 3-30 digits 

8001 Roll Products - Width/Length/Core Diameter 14 digits 

8002 Electronic Serial Number (ESN) for Cellular Phone 1-20 alphanumeric

8003 UPC/EAN Number and Serial Number of Returnable Asset 14 Digit UPC +1-16 

Alphanumeric Serial Number 

8004 UPC/EAN Serial Identification 1-30 Alphanumeric

8005 Price per Unit of Measure 6 digits 

8100 Coupon Extended Code: Number System and Offer 6 digits - numeric 

8101 8101 Coupon Extended Code: Number System, Offer, End of 

Offer 

10 digits - numeric 

8102 Coupon Extended Code: Number System preceded by 0 2 digits - numeric 

90 Mutually Agreed Between Trading Partners 1-30 alphanumeric

91 Company Internal Information 1-30 alphanumeric

92 Company Internal Information 1-30 alphanumeric

93 Company Internal Information 1-30 alphanumeric

94 Company Internal Information 1-30 alphanumeric

95 Company Internal Information 1-30 alphanumeric

96 Company Internal Information 1-30 alphanumeric

97 Company Internal Information 1-30 alphanumeric

98 Company Internal Information 1-30 alphanumeric

99 Company Internal Information 1-30 alphanumeric
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Graphic Element Group 
 

 
 
Graphic elements can be created and/or inserted into a message. Simple graphics and 
shapes such as lines, circles and rectangles can be created using the graphics tools in 
Orion. A gallery of common logos are provided as well. 

Horizontal or Vertical Line 
 

To place a horizontal or vertical line in the message mouse click on the 
“Horiz./Vert. Line” icon under the “Insert” tab or right mouse click in the 
message where you would like to place the line and select 
“Horizontal/Vertical Line” from the drop down menu. 
 

 
 
When Horizontal/Vertical is selected a small horizontal line will be placed in the current 
printhead area of the message  

 
Line created when a Jetline Printhead 
is selected. 
 
 
 
 

 
Line created when a CoPilot Printhead 
is selected 
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When the line first appears in the message it is probably not the right length, width or in 
the right position. To change the line properties, mouse click on a selection handle on 
the line and drag the handle to achieve the correct length and width. 

 

Line 
 

To place general line element in the message mouse click on the “Line” icon 
under the “Insert” tab or right mouse click in the message where you would like to 
place the line and select “Line” from the drop down menu. 
 

 
 

When the new line appears in the message use the selection 
handles to manipulate the line to correct length and weight. 
 

 

 

Original Line as Placed 
in Message 

 

Use Selection Handles to Mouse 
Click and Drag Line to Desired 
Length and Weight (Thickness) 
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Rectangle 
 

To place a rectangle element in the message mouse click on the “Rectangle” 
icon under the “Insert” tab or right mouse click in the message where you 
would like to place the line and select “Rectangle” from the drop down menu. 
 

    
 

When the new rectangle appears use the selection handles to 
manipulate the rectangle to the correct length, height and 
position. 
 

 

Ellipse 
 

To place an ellipse element in the message mouse click on the “Ellipse” icon 
under the “Insert” tab or right mouse click in the message where you would like to 
place the line and select “Ellipse” from the drop down menu. 
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When the new ellipse appears use the selection handles to 
manipulate the ellipse to the correct length, height and position. 
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Image File 
 
A variety of pre-created images such as logos and custom artwork can be placed in the 
message. Orion supports most image file types. 
 

To insert an image from an existing file select the “Image File” icon from the 
insert ribbon or right mouse click in the message where you would like to place 
the image and select “From Image File…” 
 
 

 
 
A navigation window will open. 
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Navigate to the location containing the desired image. 

Select the desired image to place in the message. 
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Double click on the desired image or click “Open” button and the graphic will be placed 
in the message. 
 

 
 

 
 
 

 
 

This is the file type you are looking for. Orion 
will accept most common image types. 
 
 

 
When the new graphic is placed in the message 
use the selection handles to resize and/or position 
the graphic. 
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Here are some examples of graphic elements placed in a message. 
 
 
 

 
 

Example of Text and Graphics in Jetline Dot Matrix Printer Message 
 
 
 
 
 
 
 

 
 

Example of Text and Graphics in CoPilot Two Head Printer Message 
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Image File Tools 
 
The size and to some extent the quality of a graphic image can be altered in Orion. 
 

Note: Please keep in mind that a graphic in Orion will never be 
better than the originally imported artwork. 

 

 
 
Change Graphic File: 

Retrieve an image file that will replace the currently selected graphic. 
 
 
 
 

 
Resize by Pixel: 

Width and height will be displayed and changed by Pixels. 
 
 
 
 

Resize by Percent: 
Width and height will be displayed and changed by percent (%). 
 
 
 
 

 
Height/Width: 

 

Height and width of a selected graphic displayed in number of 
pixels or as a percentage, also used to change the height and width 
of the selected graphic. 
 

Tint: 
Use “Tint” to put down less ink and print a lighter image. It works 
well with solid black and white images. Lower tint values will 

adversely affect the quality of grayscale and halftone graphics. 
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Keep Aspect Ratio: 
When this box is checked the height and the width of the 
selected graphic will scale proportionately when one of the 

values is changed. 

Auto Grayscale: 
When this box is checked the image is converted to a 
grayscale image when placed in the message. This will 

generally be the best quality. 

Threshold: 
Threshold is available when “Auto Grayscale’ is not checked. 
Threshold will increase and decrease the black and white 
contrast of the selected image. The Higher the threshold value 

the more gray areas will be interpreted as black. The lower the threshold more of the 
gray areas will be interpreted at white. Threshold can be used to try and improve a 
graphic. Please keep in mind that a poor original graphic will probably not improve using 
the “Threshold” tool. 
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A General Note about Image Quality 
 
While the Orion™ software package can handle a variety of image types it will not take 
a poor piece of artwork and make it look good. Best results can be had by using an 
original graphic that is a 300 dpi black and white image. A lower resolution can be used 
but quality begins to deteriorate at lower resolutions. 
 
For example, XYZ Company has a very nice logo that has been professionally created 
at a hi-quality resolution (300 dpi). 
 

 
 

Original Artwork at 300 dpi 
 
The company of course begins using the logo on its web site, business cards and 
letterheads. XYZ Company would like to include their logo in messages created using 
Orion™ and printed with a CoPilot printer. The well-meaning operator creating the 
message opens XYZ Company’s web-site and copies the logo from the web-site then 
inserts it into the message. 
 

 
 

72 dpi Artwork 
Now there are two problems here. 
 
One: The logo from the web site is dimensionally much too small. 
 
Two: The screen resolution is 72 dpi which is much too low. 
 
Suppose then, in an effort to correct the problem our well-meaning operator opens the 
logo in a graphics or illustration program and saves it as a bitmapped 300 dpi image 
then reinserts it into the Orion™ message and is once again disappointed with the 
results. Don’t do this. The only thing achieved by blowing up a small low resolution 
image is to make a poor image into a much larger poor image. 
 
What have we learned? 
The old saying “You can’t make a silk purse from a sow’s ear” tends to be true. The 
Squid Ink Manufacturing CoPilot series of printers will reproduce quality graphics only if 
a quality graphic is sent to the printer. Be aware of the resolution and size of the image 
being used by the printer. When possible use original artwork that is larger both 
dimensionally and in resolution then reduce it to the appropriate size in Orion™. 
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Element Manipulation 

Select an element by mouse clicking the element in the message. Selection handles will 
appear around a selected element. The “Properties” contextual ribbon for the selected 
element will also display. 

Click and drag the selection handles to resize the selected element. 

Click and drag on the selected element itself to move the element in the message. 

Hold the “Control” key while clicking and dragging the element to copy the selected 
element to a new location on the message. 

Properties Contextual Ribbon 
for Selected Element 

Selection 
Handles 
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Selecting Multiple Elements 
 
To select more than one element press the “Shift” key while mouse clicking on 
additional elements. 
 
You can also select multiple elements by clicking and dragging the mouse pointer to 
create a light blue selection box. All elements contained or partially contained in the 
selection box will be selected. 
 

 
 

Element Selection Box 
 
 

The first element selected will display green selection handles. 
 
 
 

 
Any subsequent elements selected will have red selection 
handles. 
 
 

For purposes of alignment and spacing the selected elements will key on the element 
with the green selection handles. 
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Clipboard Group 
 

The “Clipboard” group contains some normal functions for 
cutting, pasting and manipulating selected elements. 
 
 
 
 

 
Undo: 

Select the “Undo” icon to undo a previous command. This is a good tool if you 
have deleted elements by mistake. 
 
 

Redo: 
“Redo” will redo the previous command. 
 
 

 
Paste: 

Use the “Paste” icon to paste a copied or cut element into the message. 
 
 
 

Cut: 
Cut an element or group of selected elements from the message and save in 
the temporary clipboard. Use “Paste” to reinsert a cut element back into a 

message. 
 
Copy: 

Select the “Copy” icon to copy a selected element into the temporary 
clipboard. Use “Paste” to inset the copied element into a message. 

 
 
Delete: 
Select the “Delete” icon to delete selected elements from the message. Don’t 

forget, there is and “Undo” tool! 
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Arrange Group 
 

The “Arrange” group contains tools to align, auto-space and lock 
selected elements. 
 
 
 
 

 
Align: 

Use the alignment tool for aligning multiple elements. 
 

 
 
Auto Space: 

Use “Auto Space” to evenly space a number of selected elements. 
 

 
 
Lock Position: 

“Lock Position” will lock a selected element’s position so it can’t be moved. To 
lock and element’s position, select the element and mouse click the “Lock 
Position” icon. When an element is locked a small lock icon will appear with the 
element in the message editor. 

 

 
 

Example of “Locked” Elements 
 
To unlock a locked element, select the locked element and click on the “Lock Position” 
icon. The locked element will then become available for moving. 
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Element Group 

The “Element” group is used to affect how selected elements will print. 

Do Not Print: 
Check this box to keep a selected element in the message without 
printing it. 

Inverse Print: 
Check this box to print the selected element’s background but not the 
content. 

Invert Print: 
Check this box to print the selected element upside down (flip 
vertically). 
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User Data 
 
User Data is useful if you have a message containing several elements but one or two 
need to change occasionally. The data can be changed each time the message is sent 
to the printer. User Data can be used when inserting Text and Barcode elements. Text 
and Barcode elements containing User Data will display as blue on the Orion™ 
message creation screen. 
 

Assigning User Data to a Text Element 
 
To create a text element with User Data select “Text” from the Insert ribbon or right 
mouse click on the substrate location where you would like to place the text and select 
“Create Text Here”. 
 

In the “Text Properties” ribbon, select “User Data”. 
 
 
 
 
 
 
 

 
The “Dynamic Data” properties 
group will be displayed. 
 
 
 
 
 

Prompt: 
Enter the name for the User Data text here. If this box is left blank the prompt will be 
displayed as “Text 1”. 
 
Default Data: 

Enter the text that will be displayed as the default text here. 
 

Data Size: 
This is the maximum number of characters allowed in the text 
string. Use the arrow buttons to increase or decrease the size of 

the text string or enter the desired number of characters in the “Data Size: box. The 
default is 32 characters. 
 

Allow Blank 
Checking the “Allow Blank” box will allow the user to leave the User 
Data text box blank. 
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Numeric Only 

When the “Numeric Only” box is checked only the numeric characters 
1 thru 9 can be entered in the User Data text box. 

 
The text string will display on the Orion™ message creation screen in blue. 
 

 
 
Go to the “Message” ribbon tab and select “Send to Printer” in the Tools 
Group. 
 
 
 
 

 
 
In the “Send Message To Printer” window select “User Data…” or “OK”. Because the 
message now contains User Data the “Input User Data for Message” window will open. 
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The first time the “Input User Data for Message” window is opened it will display the text 
string previously defined as default text. 
 
In the “Input User Data for Message” enter the text to be printed. Text can be added to 
the default text string or the default text can be replaced with new text. 

 
 
Select “OK” and you will be returned to the “Send Message To Printer” window. 
 

 

Enter Text for User 
Data Here 

 

Default Text 

Prompt 
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Select “OK” in the “Send Message To Printer” window and the message containing the 
User Data will be sent to the assigned and connected printers ready for printing. 
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Assigning User Data to a Barcode Element 
 
To create a Barcode element with User Data select “Barcode” from the Insert ribbon or 
right mouse click on the substrate location where you would like to place the barcode 
and select “Create Barcode Here”. 
 

In the “Barcode Properties” ribbon, select “User Data”. 
 
 
 
 
 
 
 

 
The “Dynamic Data” properties 
group will be displayed. 
 
 
 
 

 
Prompt: 
Enter the name for the User Data barcode here. If this box is left blank the prompt will 
be displayed as “Barcode 1”. 
 
Default Data: 

Enter the data that be displayed as the default data here. 
 

Data Size: 
This is the maximum number of characters allowed in the data 
string. Use the arrow buttons to increase or decrease the size of 

the text string or enter the desired number of characters in the “Data Size: box. The 
default is 32 characters. 
 
Allow Blank 

Checking the “Allow Blank” will allow the user to leave the data string 
empty. 
 
Numeric Only 

When the “Numeric Only” box is checked only the numeric characters 
1 thru 9 can be entered in the User Data box. 
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The Barcode Data string will display on the Orion™ message creation screen as blue. 

Go to the “Message” ribbon tab and select “Send to Printer” in the Tools 
Group. 

In the “Send Message To Printer” window select “User Data…” or “OK”. Because the 
message now contains User Data the “Input User Data for Message” window will open. 
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The first time the “Input User Data for Message” window is opened it will display the text 
string previously defined as default text. 

In the “Input User Data for Message” enter the text to be printed. Text can be added to 
the default text string or the default text can be replaced with new text. 

Select “OK” and you will be returned to the “Send Message To Printer” window. 

Enter Barcode Data 
for User Data Here 

Default Data 

Prompt 
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Select “OK” in the “Send Message To Printer” window and the message containing the 
User Data will be sent to the assigned and connected printers ready for printing. 
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Custom Keyboards 
 
A custom keyboard can be created to associate with a specific message that contains 
user data. When creating a custom keyboard any character can be substituted for the 
standard keyboard characters. 

 
The Custom Keyboard Icon is available in the “Tools” Group when the 
Configure Printer window is open for a specific printer. Select the “Custom 
Keyboard” Icon and you will be prompted if you want to define a custom 
keyboard for the selected printer. 
 

 
 
Select “Yes” to open the Define Custom Keyboard window. 
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In the Define Custom Keyboard window you can define characters for each key on the 
keyboard. 

Notice the column headings are for Regular, Shift, Alt, and Shift + Alt characters. 

To change a character, select a key and enter the Custom Character in that key 
location. 

In the example below some of the regular number keys and shift keys have been 
replaced. 

New Characters Entered in Keyboard Map 

The character changes will appear in the “Keyboard Preview”. 

Keyboard Preview 
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After the custom characters have been defined select “OK”. If there are undefined keys 
on the keyboard you will be prompted if you would like to leave them blank. Select 
“Yes” to continue or “No” to go back and define the empty keys. 
 

 
 
If the same character has been assigned to duplicate keys you will be prompted if this is 
what you really want to do. 
 

 
 
Select “Yes” to continue or “No” to go back and redefine the duplicate keys. 
 
A progress window will display while the custom keyboard is sent to the printer. If new 
fonts are downloaded the printer will automatically reboot when the transfer is complete. 
 

 
 

 
 
After the custom keyboard has been updated select “OK”. 
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This will reset the keyboard to the default values. 
 

 
If you select “Reset to Default Preset” you will be prompted if this is what you really 
want to do. 
 

 
 
Select “Yes” and the keyboard will reset to the default values. 
 

After the keyboard characters have been defined select “Save 
Preset…” to open a standard navigation window. 
The navigation window will open to the default location: 

C:\Squid Ink\Orion\Custom\Keyboard. To use another location, select a different name 
and location to save the new custom keyboard. 
 

 
 
Select “Save” to save the custom keyboard. 
 

Note: The default location for saving a custom keyboard is 
C:\Squid Ink\Orion\Custom\Keyboard 
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To load a previously created custom keyboard select “Load 
Preset…”. 
 

 
 
Highlight the desired keyboard from the list at the stored location and select “Open”. 
 

 
 
You will be prompted if you want to overwrite the exiting keyboard. Select “Yes” to load 
the selected custom keyboard. 
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Selecting “Disable Custom Keyboard” will disable the 
custom keyboard and send the standard keyboard to the 

printer. 
 
When you select “Disable Custom Keyboard” you will be prompted if this is what you 
really want. 
 

 
 
Select “Yes” to disable the custom keyboard and send the standard keyboard to the 
printer. 
 
What is the difference between “Disable Custom Keyboard” and “Reset to Default 
Preset”? Disable Custom Keyboard will send the standard keyboard to the printer but it 
will not change the current custom keyboard in Orion™. “Reset to Default” will reset the 
current keyboard you are creating to the default values. 
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Auto Data 
 

Selecting “Auto Data” causes the object you are editing (text, barcode 
or graphic) to become sensitive to external data from a database. 
 
 
 
 

Typically, the “Default Data” text string that 
you type for the object is a default text that is 
shown as a place holder, such as the name 
of the database field. Text entered in the 
Default Data box can also be printed before 
any Auto Data is sent to printer. 
 

The procedure for using Auto Data, in brief, is as follows. Enable Auto Data for all 
objects in your message file whose string you want to be fed from external application 
like (a typical example is an application retrieving data from a database then send to 
printer to print). Send your message file over the Ethernet to the printer. Run your 
application and start sending data to printer through TCP command. (See more details 
in “Write AutoData Record” command in your printer’s Communication Manual)  
 

When you first enable Auto Data in the Attributes dialog, 
Orion™ will place the next available Auto Data index into the 
“Index” field. You may then change that value if you wish. 

The indexes you use for Auto Data objects must run consecutively from 1 to the total 
number of Auto Data objects in your message. They must also have the exact order that 
your data fields occur in each record. For example, if you are printing addresses with 
the fields “Name”, “Address” and “City” occurring in that order in your database, then 
you might create three text objects, designate them with the string values “Name”, 
“Address” and “City”, and enable them for Auto Data giving them index values 1, 2, and 
3, respectively 
 

One Shot Mode 
 
When a message is configured for Auto Data and One Shot Mode is selected, the 
printer will not use the queue when it receives an Auto Data record. This means that if 
the printer has received a record but hasn’t printed it yet, the next record will overwrite 
the current record instead of being placed in the queue. 
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Repeat Mode 

When a message is configured for Repeat Mode, it will be printed repeatedly as long as 
the trigger is active. The Length specifies how often the message is repeated (based on 
the selected Unit). The Quantity specifies the total number of times it is printed. Repeat 
Mode is often used when printing on long substrates and extruded material. In order to 
print a continuous line, you have to set the Repeat Length to 1 column longer than the 
length of data being printed. This causes the printer to repeat as soon as it’s finished 
with the first print. Orion simply sets the required values eliminating the need to figure 
out how long the message is and what the Length value should be. 

Note: Repeat mode and Auto Data One Shot Mode should never 
be used together therefor they are mutually exclusive. 
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Database Message Server 
 
 
The Database Message Server is an Orion message creation function that is used to 
create dynamic messages from a template and sent to the printer(s). The message is 
populated with data retrieved from a predefined database table. 
 

Note: To use the Database function, Orion™ must include the 
optional Database Message Server Feature License. 

 

Example Database 
 
To illustrate how the Orion Database server is used I have created a very simple 
Microsoft Xcel™ worksheet. 
 
From the late 1960s to the early 1970s the United States sent nine expeditions to the 
moon. Here is a simple worksheet containing some information about those lunar 
missions. 
 

 
 

Sample Database File 
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Create a Template Message 
 
Launch Orion in the normal fashion and create a new message. As an example I’m 
going to create a new message called “Lunar Expeditions”. 
 

 
 

Orion™ Message Creation Screen 
 
In the above example the message has been created for the CoPilot Printer with two 
256 printheads. 
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Create the static elements for the message. In this example I have created some static 
text in the message. 

Create a Database Connection 

Select the “Database Connection” icon to open the “Printer Database 
Connection” screen. 
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Database Type: 
Select the desired database type from the “Database Type” drop down menu. 
 

 
 
For this example I have created a Microsoft Excel™ File titled “Lunar Expeditions”. 
 
After selecting the database type, use the browse button to navigate to the desired file. 
 

 
 
Open the desired Database file. In this example I’m going to open “Lunar Missions” 
Excel™ Worksheet. 
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Printer Database Connection Window 
 

 
Check this box to use the first row of the Excel™ file as a message database field 
header. 
 

 
Select the sheet from the database file that will be used in the message. The example 
message contains only one sheet. Sheet1 is selected. If there are multiple sheets in the 
database use the drop down arrow to select the desired sheet. 
 

 
Checking this box will save the database connection information for future use. The 
database connection will then appear in the “Saved Database Connection” drop down 
list. 
 
Select “OK” and the message will be connected to the database file. 
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Creating a Place Holder 
 
To print the data from the connected database we will need to create a place holder in 
the message for each database field. 
 

In the open message select “Create Text 
Here” where you would like to place the 
associated database field. Do not enter 
any text here. 
 
 
 
 
 
 
 
 
 
 
 

 
Select “Database Field” from the Dynamic Data group 
located at the top right of the message tools ribbon. 
 
 
 
 
 
 
 
 
 

 
Notice in the Dynamic Data tools group 
there is now a “Field” box with a drop 
down arrow. Use the drop down arrow to 
see a list of field headings from the 
connected database. 
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Fields are listed in alphabetical order. Select the desired field. In this 
example I am selecting “Mission” to position so it will print under the 
static text “Mission Designation” on the substrate. 
 
 
 
 
 

The text font and size can be selected in the normal fashion. 
 

 
 
Data that is associated to a connected database will be displayed in a green color. 
Static elements are displayed in the normal black color. In the above example “Mission” 
is displayed in green. 
 

 
Here the message is populated with place holders for the related fields in the connected 
database. 
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Send the Message to the Printer. 

Send the message to the connected printer(s) in the normal fashion. The 
message template will then appear in the preview section on the designated 
printer(s) home screen. 

Home Screen Database Message Server 

From the Orion message Home Screen select the “Database Message 
Server” icon to open the “Orion Database Message Server” Screen. 



Database Message Server   167 

 
 

Orion Database Message Server Screen 
 
Notice the red “SERVER STOPPED” TAB along the bottom of the window. This is 
normal. We will be starting the server shortly. 
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Server Settings 
In the Orion Database Message Server Screen select “Server 
Settings” so the printer can identify the server as opposed to 
using an IP address. 

 

 
 

Server Settings Screen 
 
Server ID: 
Enter an ID name for the server. As this is a demonstration, the server ID in this 
example is “Demo 1”. 
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Database Connection: 

 
 
Database/Table 
In the “Database Connection” group use the “Browse” button next to “Database/Table” 
to locate and select the database connection. 
 
Data ID Column: 
Use the drop down arrow in the “Data ID Column” to select an ID field for the message. 
In this example I have selected the “Mission” field. 
 
Communication Settings 

Check the “Custom settings:” box to 
change and apply the communications. In 
this example we are not using any 
custom settings. 
 
 
 
 

 
Printer Status Update 

Use to define how often Orion will update 
the printer status and refresh the print 
bitmap on screen. 
 
 
 
 
 

 
 
 

Select “OK” to return to the Orion Database Message Server window. 
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Data ID ó Message 
The Data ID is essential for the printer to be able to retrieve 
remote messages from the connected database. Select the “Data 
ID ó Message” button to open the Data ID & Message window 

 

 
 
In the Data ID and Message window we’ll tell Orion™ which message template to be 
used for specific “Data ID”. We can set the template message for Data ID one by one or 
select them in a batch. 
 

In this example I’m going to select all “Data ID” because they’re 
associated to the same message template. 
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Set Message… 
Select the “Set Message…” button to open the “Specify message 
for selected Data IDs” window. 

Print Station: 

Use the drop down arrow in the “Print Station:” box 
to select the print station where the desired  
message resides. 
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Select the desired Message name. In this example “Lunar Expeditions” has been 
selected. 
 

 
 
After the message has been selected, the Substrate Surface to Preview: will update and 
display a preview of the message. If the substrate preview does not update or is not 
present, use the down arrow to select the correct substrate. 
 
Select “OK” and we are returned to the “Data ID & Message” window. Notice that in this 
example all the messages are highlighted and the Message column is filled with the 
message template we just selected “Practice3\Lunar Expeditions”. 
 

 
 
Select “OK” to return to the Orion Database Message Server. 
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Send Message 
Select the “Send Message” button to send the batch of 
messages to the printer. 
 

Check the box next to the message you wish to send to the printer. 
 

 
 
In this example I want to send all the messages to the printer so I have selected “Check 
All”. 
 
After checking the desired message(s) select “OK”. 
 
Select Data ID to Print 

 
 
This dropdown list box will contains all Data 
IDs you have selected. You can select one 
to tell printer which message to print 
immediately. If you just want to send them to 
printer, select “(None)”, it won’t change 
current printing message on the printer. 
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The “Send Message to Printer” window will open and display progress as the 
message(s) are transferred. 
 

 
 
When the transfer is complete, close the “Send Message to Printer” window. 
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Start Server 

 
 
Select the “Start Server” button to start the server. 
 

 
 
The server we created earlier is now running. Notice the red “Server Stopped” tab along 
the bottom of the window has now changed to a green “SERVER RUNNING” tab. 
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Start Monitoring Selected Printer 
Monitoring the selected printer is not necessary to print 
database messages however is a useful tool to watch 
what is happening on the printer side. 

Select the “Start Monitoring Selected Printer” button. 

Select the desired printer tab and the current message on the printer will display. 

Message Displayed from the Selected Printer 

At the Printer 

Go to page two of the settings screen on the printer a select the Database icon. 

Settings Screen Page Two 

Database 
Icon 
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The Database screen will open on the printer. 
 

 
 
Make sure the “Remote Mode” is “ON” and select the “Remote Server” tab. In the 
Remote Server screen use the search icon to find the server. 

 
Select the “Apply” icon to connect to the message server. 
 

Tip! Now would be a good time to return to the “Start/Stop tab 
and ensure you have the remote server turned “ON”. 

 
Return to the printer “Home” screen. 
 
 

 

 

Search 
Icon 

Server Name 
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At the printer home screen select the message folder icon. Use the onscreen 
keyboard to enter the message you want to print. 
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Home Screen Displaying Current Message from Database 

 
The current message will now be printed. 
 
 

 

Enter Message 
Name Here 

Select “Apply” to 
Load Message 

 

Current Message Display Current Message from 
Database 
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Auto Data Server 
 
 

Auto Data Server Description 
 
When you want to feed variable information to a printer form an external source, the 
printer must have a way to accept this information. The way the printer accepts this 
information is by printing an Auto Data Template message. An Auto Data Template 
message contains at least one Text, Barcode and/or Graphic element that is configured 
to accept Auto Data. When the message is initially loaded, the “Default Data” you enter 
for Text and Barcode elements or the graphic you use for Graphic elements will be 
printed as a placeholder. Once the printer receives an Auto Data record, it will rebuild 
the message, placing the various fields into their associated elements. 
 

Note: The optional Auto Data Server function is only available in 
the Orion™ Tier Three License level. 

 

Create a Template Message 
 
Create an Auto Data Template message. This is a message that contains Text, Barcode 
and/or Graphic elements that are configured to accept Auto Data. 
 

To configure an element to accept Auto Data, you will select 
the element then click the “Auto Data” button in the 
Dynamic Data section of the Properties ribbon. Once Auto 
Data has been enabled, you will see the following properties 
to configure: 
 
 
 
 
 
 
 

Data Index: 
This value indicates which field to use when an Auto Data record is 
received. This value will be pre-set to the next available number not 

already being used, in the range of 1-32. You usually don’t need to change this value, 
but you can if you need to. Just make sure the resulting message contains values 
starting at 1 and all are continuous. 
 
Data Size: 

This tells the printer how many characters you plan to send for this 
element. If too many characters are received, the printer will use this value to limit how 
much data is used. 
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Default Data: 
For Text elements, this is the text that is printed before the 
printer receives an Auto Data record. For Barcode elements, 

this is the data that is embedded into the barcode before the printer receives an Auto 
Data record. Graphic elements don’t have the Default Data option available to them, so 
the printer will print the graphic you added to the message before it receives an Auto 
Data record. 
 
Save: 
Save the template message and send it to the printer. Before any Auto Data is sent to 
the printer, the message will print just as it looks in Orion™. All of the default information 
is printed so that you can verify everything looks as expected. 

 
 

Example of a Template Message 
 

 

Static Elements Are 
Displayed as Black 

Auto Data Elements 
Are Displayed as Red 
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Message and Related Database Fields 
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Server Settings 
 
When you click the “Auto Data Server” icon in the Tools section of the Home ribbon, 
the Auto Data Server dialog will appear.  

 
 
Click the “Server Settings…” button to configure to following: 
 

• Data Source 

• Print Mode 

• Print Quantity 

• Graphic File Location 

• Logging 

• Template Message 

• Data Assignments 

 

 

Server Settings 
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Auto Data Server Settings Window 
 

Data Source 
 
Data Fields: 

 
This is where you select the database you want to extract data from. Data sources can 
be: 
 

• Microsoft Access Database 

• Microsoft Excel 

• Microsoft SQL Server 

• Oracle Database 

• Plain Text File 

Use the “Browse” button to navigate to the desired Data Source location 
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Once you select the type of data source, you can set the additional parameters required 
in order to extract the data you need. 
Records(s): 

 
Once you have selected the data source and configured it for access, you can select 
the records you want to send to the printer from a list of all available records in the 
selected data source. You can select single records, groups of singles or ranges, or all 
records. 
 
Selecting the “Browse” Button will display a list of records in the selected database. 
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Print Mode 

 
 
There are various options for selecting how data is printed. 
 
Single Record Repeat: 

 
Print the selected record until a different record is selected. This button is only available 
if a single record has been selected and the message is not configured for “One Shot” 
mode. 
 
Sequential: 

 
This will print all the selected records and then stop printing. 
 
Sequential Repeat: 

 
This will print all the selected records and then repeat. 
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Print Quantity: 

There are various options for selecting how many times a record is printed. 

Print each record once: 

This will print each record once. For example, if there are 24 records it will print records 
1 thru 24 then stop printing. 

Print each record multiple times: 

Print each record a specified number of times (2-65535). 

Use this field to indicate the number of times to print that record: 

Use a field from the selected data source to indicate the number of times that specific 
record should be printed. 

Use the drop down arrow to display the database fields. 

Note: These options may vary based on how the selected 
Template Message is configured. If the message is 
configured for “One Shot” mode, only the “Print each record 
once” option will be available. 

Printer status frequency: 

Use this to specify a number of seconds between records. 
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Log all activity to this folder: 

 
When this box is checked a user can keep track of which Template Message is used, 
which graphic files are sent to the printer, and which Auto Data records are sent to the 
printer. Use the “Browse” button to select the target folder where the log file will be 
saved. 
 

Message: 

 
The user must select an Auto Data Template message from any available Print Station 
and message that Orion has access to. Use the “Browse” button to find and select the 
desired message. 
 

Note: If a message that contains no Auto Data is selected, the user 
is asked to make another selection. 

 

Data Assignments: 
Once a Template Message has been selected, a tree will be displayed showing all of 
the Auto Data elements contained in that message. The user must then select a field to 
be assigned to each Auto Data element. Use the drop down arrow to select the desired 
field. 

 
 

 

Auto Data 
Element 

Database 
Field 
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Elements with Assigned Data Fields 

Start Server: 
Once the Auto Data Server has been configured, click the 
“Start Server” button to send the template message to the 
required printer(s), build the message, send all required 

graphic files from the specified graphic location and then start sending Auto Data 
records. 
 

 
 
When the server has finished sending all the records the printer will print the messages 
as configured when triggered. 
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Adding a Graphic 
 
If an Auto Data record contains a graphic such as a logo it can be added to the 
message just like any element. In the case of graphic elements, just the file name needs 
to be sent to the printer and the printer will load that graphic file into the message, if that 
graphic file exists on the printer. Auto Data can accept several types of graphics such 
as PNG, JPG, GIF and BMP but the graphic must have the .BMP extension in the 
database field. 

Template Message: 
Place a graphic element in the template message. This will be a place holder for graphic 
elements contained in the record when the message is printed. 

 

Configure the Graphic Element: 
To configure the graphic element to accept Auto Data select the 
element and then then click the “Auto Data” button in the Dynamic 
Data section of the Properties ribbon. 
 
 
 

Notice that the graphic element now is displayed in red indicating that it is a dynamic 
element. 

 

 

Graphic Element Placed 
in Template Message 

 

Graphic Element 
is Now Red 



Database Message Server   191 

With the graphic selected, configure the 
graphic in the normal fashion with the 
exception that there is no “Default Data” 
associated with graphic elements. 
 
 

 
Template Message with Related Database Image Field 

 
Notice! In the above example all the graphic elements in the “Image” 

field have the “.bmp” extension. They need not be bmp files 
but they must have the .bmp extension when listed in the 
associated database. 

 
Save the template message and send it to the printer. 
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Data Assignment: 
In Auto Data Server Settings assign the place holder element a Database field. 

Sending the graphic Files to the Printer: 
To print a graphic element associated with a database record the graphic file must 
reside in the printer. 

Attention! The graphic file names in the database record must end with 
a “.bmp” extension. The graphic file itself need not be a 
.bmp file but the file name must have a bmp extension. 
When the printer receives and prints a database record 
containing a graphic it will look for a .bmp file. If it doesn’t 
see a .bmp the message will still print but without the 
associated graphic. Also keep in mind that accuracy is very 
important when entering the file names into the database. 
Typos and incorrect upper and lower case will prevent a 
graphic element from printing. 

Place Holder 
Element 

Database 
Field 
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Use the “Process and copy graphic file(s) to the printer(s)” button in Server Settings 
to copy graphic files onto the printer(s). 
 
The “Select Graphic Files” window will open. Select the graphic files that you wish to 
copy to the printer(s) and select “Open”. 
 

 
 
A progress window will display briefly while the files are converted. 
 

 
 
Another progress window will briefly display as the target printer(s) are checked for free 
space. 
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A progress window will display as the graphic files are copied on to the target printer(s). 
 

 
 
After all the files have been copied to the target printers select “Close” to close the 
“Send Graphic Files to Printer” window. 
 
The Auto Data linked graphic is now part of the message and will print with the 
associated record. 
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Print Station/Message Data Transfer 
 
All the data pertaining to existing print stations and or messages can be saved to 
another location. For example, print stations created in Orion™ on a desktop work 
station can be exported and saved to a USB Stick, connected tablet, desktop computer 
or a remote file server. All the relative data associated with the print station including 
messages and printers can be transferred and saved. 
 
Transferring print station and message data across platforms is done in two steps: 
 

• Export the print station/message data to a storage device. For example a USB 
drive or a connected LAN server. 

 
• Import the print station/message data from the storage device to the desired 

platform. For example, a tablet or another desktop computer at a different 
location. 

 

Print Station/Message Export: 
 
To export print station and message data, select “Options” from the “File” window. 
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In the “System Options” window select the Print Station/Message Tab. 
 

 
 

In the “Print Station/Message” window select “Print 
Station/Message Export”. 
 

 
 
A list of all the print stations will display in the Print Station/Message Export window. In 
the above example there are three print Stations shown. 
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Checking this box will delete all the existing print stations and messages in the target 
folder. 

Attention! “Clear all existing print stations and messages in Orion first” 
will delete all print stations and messages in the target 
folder. Not only duplicates but all the print station and 
message data in will be deleted. 

Checking this box will export only those printers referenced in the selected print 
stations. Leaving the box unchecked will export data for all the currently registered 
printers. 

Check the Print Station(s) you wish to copy and select “OK”. 

The “Browse For Folder” window will open. 

In the “Browse For Folder” window you 
can navigate to the desired location or 
create a new folder to save the Print 
Station/Message data. 

Choose a folder location that can be 
accessed by the intended target device 
such as a USB drive or connected LAN 
server. 

To make a new folder, select the “Make New Folder” button and 
create the new folder at the desired location. 

Tip! It is not necessary to create a new folder. However, creating a new 
folder with a unique name that is specific to the print station and 
messages will help manage message storage and retrieval. 

Select “OK” to export the Print Station/Messages to the destination 
folder location. 
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While the data transfer is taking place a progress window will display. 
 

 
 
Notice that all the data contained in the Print Stations have been saved to the new 
location including messages and associated printers. 
 

When the successfully exported 
window appears, select “OK”. 
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Print Station/Message Import: 
 
You can import print station and message data from a selected location where the 
information has been stored. 
 
To import print station and message data, select “Options” from the “File” window. 

 
In the “System Options” window select the “Print Station Message” Tab. 
 

 
 

 In the “Print Station/Message” window select “Print 
Station/Message Import”. 
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The “Browse For Folder” window will open. 
 
In the “Browse For Folder” window you can 
navigate to the location where the desired print 
station(s) reside. 
 

Select “OK” 
 

 
 
 
 
 
 
 
 

The “Print Station/Message Import” 
window will open and display a list of 
print stations residing at the specified 
location. 
 
Place a check next to all the print 
stations you wish to import. 
 
 

Select “OK”  
 

 
 
 
 
 
 
 

 

 
Checking this box will delete all the existing print stations and messages in  your current 
Orion folder. 
 

Attention! “Clear all existing print stations and messages in Orion first” 
will delete all print stations and messages. Not only 
duplicates but all the print station and message data in will 
be deleted. 

 

 
Checking this box will import only those printers referenced in the selected print 
stations. Leaving the box unchecked will import all printers contained in the Import 
folder. 



Print Station/Message Data Transfer   201 

A progress window will open while the data is being imported. 
 

 
 

When the successfully imported 
window appears, select “OK”. 
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Operator Mode 
Orion has the capability of entering a mode in which the user is locked out of most 
program functions except selecting message files, transferring them to the printer and 
some settings functions called the “Operator Mode”. This prevents unauthorized 
personnel from editing message information in error or creating undesirable messages. 

Click on the “Operator Mode” icon to open the “Operator Mode Settings” window. 

“Unlock Password” is a key that you define to 
later unlock the operator mode and return to 
the “Design Mode” You can define any 
password you want. Keep in mind that it is 
case sensitive. You can leave both boxes 
blank if you don’t want to set a password. 

The “Enter Operator Mode On Startup” 
checkbox allows you to specify that from now 
on whenever you start the Orion program you 
will immediately be put into the operator mode 

“Don’t Allow the Operator to Exit Orion 
Software” will keep the operator in the Orion 
software and prevent unauthorized use of the 
desktop computer. 

Attention! Remember the password you created to enter Operator 
Mode. You will need it to exit Operator Mode and return to 
the Design Mode. 

Select “Enter Operator Mode” to enter the operator mode. 
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The Operator Mode will display the connected printers associated with the current print 
station. 
 

 
 

Highlight the desired printer and select “OK”. 
 

 
 

 
 
When the printer is connected the current message and information for the connected 
printer will display. 
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Operator Mode Change Message 
 
To select a different message to print select the message Icon. 
 
 
 
 

The message window will open and display a list of available messages. 
 

 
 

Place a check  in the box next to the desired message 
and select the “Print the Message” button located in the 
lower right corner of the screen. 

 
Notice the message currently residing in the printer and printing has a little 
Squid Icon next to it. 
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Message Export Operator Mode 
Select the “Export” Button in the Operator Mode to export a message 
to a connected USB drive. 

The “Export to Removable Disk” window will open. 

Checking this box will clear all existing Orion™ messages from the USB disk. It will not 
affect unrelated data that may be stored on the same drive. 

Click on the button containing the target drive to export the message(s). 

A progress window will display briefly followed by a message successfully exported 
notice. 
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Message Import Operator Mode 
Select the “Import” Button in the Operator Mode to import a message 
from a connected USB drive. 
 
 

The “Import from Removable Disk” window will open. 
 

 
 
Click on the button containing the USB drive where the messages are residing to import 
the message(s). 

 
A list of message residing on the selected USB drive 
will display. 
 

Check  the box next to the messages you would like 
to import. 
 

After all the desired messages have 
been checked select “OK”. 
 

 
 
 
 
 
 

A progress window will display briefly as the messages are imported. 
 

 
 
The imported message(s) can now be selected and printed in the normal fashion. 
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Selecting a Different Printer in Operator Mode 
 
To change printers in Operator mode select the “Select Printer” Icon. 
 
 
 

The list of connected printers will display. 
 

 
 
Highlight the desired printer and select “OK”. 
 

Orion™ will then connect to the newly selected printer and display the current message 
residing in the printer. 
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Operator Mode Settings 
 
There are several printer settings that can be changed while in the Operator mode. 

 
To go to the settings screen, select the “Setting” Icon. 
 
 
 
 

 
The “Setting” screen will open and display a list of printer settings that can be accessed 
while in the Operator Mode. 
 

 

 

 
 
A detailed description of what each setting does can be found in the User Guide that 
was supplied with your printer. 
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Return to Design Mode 
 

To return to the design mode select the “Log Out” Icon. 
 
 
 
 

 
Enter the password that was defined and select 
“Return to Design Mode” 
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Generating Random Code Files 
 
 
Orion can create a batch of random code files that can be saved as text files and 
printed. 
 
To generate a Random Code File select the “Random Code” Icon located in the “Tools” 
group. 

 
 
The “Generate Random Code File” window will open. 
 

 
 
 

 

Random Code 
Icon 
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Random String Tab 

Under the “Random String” Tab you can define the types of characters and parameters 
for the random code. 

“Characters to Use” defines the type of characters to use in the random code. 

Check this box to use numeric characters 0 thru 9. This is the default 
setting. 

Check this box to use upper case characters A thru Z. This is the default 
setting. 

Check this box to include lower case characters in the random code file. 

Check the “Other” box to include other characters in the random code. Enter the other 
characters you wish to use in the character box. 

“Character Count” will define the number of characters used in the random code. Enter 
an upper and lower value. The random code will be any length between and including 
the two values. 
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Random Numbers Tab 
 
Under the “Random Numbers” Tab you can define the numbers and parameters to be 
included in the random code. 
 

 
 

 
Enter the lowest number to be used in the random 
code. The default is 0. 

 
Enter the highest number to be used in the random 
code. The default is 255. 

 

 
The “?” will represent one character or number. You can also define a character or 
number by entering in this box. (For example, A1?????B2?????C3????). 
 

Check this box to make hexadecimals and decimals part of the random 
code. 

 

 
“Number Count” will define the number of characters used in the random code. Enter 
an upper and lower value. The random code will be any length between and including 
the two values. 
 

 
The “Samples:” box will display a preview of some random codes that may be 
generated. 
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Use the up and down arrow keys or enter the number of codes 
you wish to generate. The default is 1000. 
 
 

 
Check “No Duplicate Codes” if you wish to ensure that no 
random code is duplicated. 

 

Saving the Random Code 
 

 
 
To save the random code file select “Generate and Save to File…”. 
 
The “Save As” window will open. 
 

 
 
Navigate to the location where you wish to save the .txt file. In the “File name:” box 
enter the file name. 
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Select “Save” to save the file. 
 
 

A progress box will display briefly while the random code is generated and saved. 
 

 
 

 
 
After the random code has been generated and save select “OK”. 
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Installing System Updates 

Occasionally software and/or firmware updates will become available from Squid Ink 
Manufacturing. Software and Printer System Firmware can be updated from the desktop 
via Orion™. Periodically check to see if updates are available. 

Downloading Updates 

To download updates the desktop PC must have the Orion™ graphical software 
package installed and have internet access. 

Open the Orion™ Graphical software package in the normal fashion. 

In the Orion™ software package select the “File” tab. 

Select the “Options” Tab located at the bottom of the “File” window. 

The “System Options” Window will open. 

Options 
Tab 
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System Options Window 
 

In the System Options Window select the 
“Check for Updates…” button. The 
“Check for Updates” window will open. 

 

 
 

Check for Updates Window 
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The “Check for Updates” will display the current version of Orion™ and the current 
software/firmware version for any connected and licensed printers. Any available 
updates will also be displayed. Select “Yes” to download any available updates. 

 
After selecting “Yes” the available updates for Orion™ and any connected printers will 
begin to download. A progress window will display during the downloading process. 
 

 
 

Download Progress Window 
 
When the download is complete, “Download successfully” will display. 
 

 
 

Download Successful Window 
 

 

Select “Yes” to Download 
Available Updates 
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After the updates have been downloaded select “OK”. 
 

 
After selecting “OK” the following window will open. 
 

 
 
Select “Yes” to close Orion™ and install the updates. 
 

 
 
The new current software version will display in the “Update Installed” window. 
 
Select “OK” and resume normal operation. 
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Updating Software/Firmware to Connected Printers 

Open the Configuration Window for a connected printer. 

Double mouse clicking on a printer in the Printer Connection Status panel will open the 
Printer Configuration window for that printer in the Orion™ workspace. You can also 
open the configuration window for a selected printer by selecting the “Printer 
Configuration” icon for a highlighted printer in the print station explorer list. 

Printer Configuration Window, General Tab 

Double Click on Desired Printer to Open 
the Printer Configuration Window 
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In the Printer Configuration Window 
General Tab select “Install the latest 
version”. 

 

 
 
Select “Yes” to begin updating the printer. Updating will take about six (6) to ten (10) 
minutes. During the system update an update progress window will display. 
 

 
 

Printer Firmware & Software Update Progress Window 
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After the update has completed, select “Close” in the Printer Firmware 
& Software Update Window. 

 
After selecting “Close” you will be prompted with the following message. 
 

 
 
Select “OK” to continue. 
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A progress window will display briefly while the new printer configuration is reloaded. 
 

 
 
After the new configuration for the printer has loaded, close the printer Configuration 
Window. When the Printer Configuration Window is closed you will be asked to save the 
changes. 
 

 
 

Select “Yes” to save the changes to the printer. 
 

 
A progress bar will display briefly as the changes are saved. 
 

 
 

 
 
After the changes have been saved, select “OK” and resume normal operation. 
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Export Updates to USB 
 
Updates can be exported to a connected USB drive and physically transported to the 
desired printer. 
 

Attention! When exporting updates to a USB drive it is important to 
know the current level of software and firmware currently 
residing in the target printers. 

 
At the Target Printer(s): 

To find the current software and firmware levels, at the printer select the 
“Settings” button to open the Settings screen on the printer. 
 

 
 

In the settings screen select the Printer “Information” Button and the 
information screen on the printer will display. The information screen contains 
the current Firmware and Software versions residing in the printer. 

 

 
 

CoPilot Printer Information Screen 
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At the desktop: 
After downloading updates from the internet and Orion has restarted connect a USB 
drive to the PC where Orion and the updates reside. 
 

In the Orion™ software package select the “File” tab. 
 
 

 
Select the “Options” Tab located at the bottom of the “File” window. 

 
The “System Options” Window will open. 
 
 
 
 
 
 
 

 

Options 
Tab 
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System Options Window 
 

In the System Options window 
select the “Export Updates to USB 
Disk button 

 
The “Export Updates to USB Disk” will open. 
 

 
 

Export Updates to USB Disk Window 
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In the “Export Updates to USB Disk” 
window place a check mark next to the 
updates you wish to export to the 
connected USB drive. 

When updating a Copilot printer in most instances the “CoPilot Update Package” should 
be selected. The “CoPilot Fundamental Package” should only be selected if the target 
printer has not been updated before version 02.02.02. Generally you would not check 
both the “CoPilot Update Package” and the “CoPilot Fundamental Package” for USB 
export. 

Attention! Go to the printer(s) you wish to update and determine the 
current software level residing on the printer(s). If the CoPilot 
software version is below 2.2.2 you must update the 
“Fundamental Package” first. If the current software level is 
already above 2.2.2 simply check the latest “CoPilot Update 
Package”. 

After the desired updates have been checked select “OK”. 

If both the “CoPilot Update Package” and the “CoPilot Fundamental Package” have 
been checked this warning will appear. 

If the current software level in the target printers is above version 02.02.02 select “Yes” 
to export the selected updates to the USB drive. 

Warning! If the current CoPilot software is below Version 02.02.02 you 
must update to the “Fundamental Package” Version 
02.02.02 before updating to the latest CoPilot Update 
Package”. 
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Orion™ will detect any connected USB drives. Select the intended target drive. 

A progress window will display briefly while the updates are exported to the selected 
USB drive. 

Select “OK”. The printer software and firmware updates now reside on the USB drive. 

To update a printer insert the USB drive into the desired printer. After a few seconds the 
printer will show a USB screen containing an “Update Firmware/Software” Icon. Press 
this icon and the update will begin. Update will take from six (6) to ten (10) minutes to 
perform. 
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Customer Support 
Squid Ink Technical Service 

For help installing and using the Orion Graphical Software Package, please contact 
Squid Ink Technical Service at one of the numbers listed below. 

800-253-2627
(55) 5426-4137

Phone  
 

E-mail
Web

Thanks again for your purchase of Squid Ink products. We are pleased to be a part of 
your marking and coding needs. 

info@alfamaq.mx
www.alfamaq.mx

mailto:info@squidink.com
http://www.squidink.com/





